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Welcome to the Spire CX250 Color Server User 
Guide

Welcome to your Spire™ CX250 Color Server 1.0 for Xerox® DocuColor 
240/250 Printer-Copier User Guide.

The Xerox DocuColor 240/250 printer-copier is a powerful, 
comprehensive color server that provides high throughput and print 
predictability to digital workflows. In combination with the Xerox 
DocuColor 240/250 printer-copier, the Spire CX250 color server 
effectively addresses the growth of on-demand printing needs and delivers 
the best output quality available. 

Throughout this guide, we look forward to supporting you all the way 
from prepress to print.

This user guide will help you operate the Spire CX250 color server. It can 
also be used as a reference guide for questions or procedures. Study this 
user guide to take full advantage of the many unique and advanced features 
of the Spire CX250 color server.

This user guide is for Spire CX250 color server operators and system 
administrators. This guide explains how you can quickly and easily print 
from the Spire CX250 color server or from a client workstation. Step-by-
step procedures are included for new and occasional Spire CX250 color 
server users. Detailed information is provided for users who require in-
depth knowledge of the Spire CX250 color server.
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Terminology
The Spire CX250 color server is available in three configurations:

Table 1: Terminology

Configuration Description

Spire CX250 color server 
(“basic configuration”)

Spire CX250 color server mounted on the Xerox DocuColor 240/250 
printer-copier

Spire CX250 color server with 
Control Station Upgrade Kit 
(“Control Station 
configuration”)

Upgrade kit that includes the Spire CX250 color server mounted on a 
stand, monitor, keyboard, mouse, and DVD-ROM. A dongle is 
required for this configuration.

Note: The Spire CX250 color server is a prerequisite for this configuration.

Spire CX250 color server with 
Professional Upgrade Kit 
(“Pro configuration”)

Upgrade kit that includes X-Rite DTP34 QuickCal densitometer and 
advanced software features. A dongle is required for this 
configuration.

Note: The Spire CX250 color server and Control Station upgrade kit are 
prerequisites for this configuration.
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Overview of Guide
Table 2: Guide Overview

Chapter Contents Description

Chapter 1 Welcome This chapter introduces the guide and the Spire 
CX250 color server features and workflows.

Chapter 2 Spire CX250 Color 
Server Basic 
Configuration 
Workflows

This chapter introduces the basic workflows for users 
of the Spire CX250 color server basic configuration, 
including defining the Xerox DocuColor 240/250 
printer-copier on a client workstation, working via 
the Remote Desktop Application, calibrating and 
scanning.

Chapter 3 Getting Started This chapter introduces the workflows for users of 
the Spire CX250 color server Control Station and Pro 
configurations, and provides explanations about the 
Spire CX250 color server workspace and main 
windows.

Chapter 4 Basic Workflows This chapter explains how to import to and print jobs 
from the Spire CX250 color server.

Chapter 5 Printing From Your 
Computer

This chapter explains how set up Windows and 
Macintosh client workstations. 

Chapter 6 Generating Reports This chapter explains how to generate reports from 
the Spire CX250 color server and the Xerox 
DocuColor 240/250 printer-copier.

Chapter 7 Color Workflow This chapter explains how to work with color in the 
Spire CX250 color server, and includes calibration 
and RGB and CMYK workflows. It also explains how 
to adjust colors, and to use color tools and post-RIP 
controls.

Chapter 8 System Administration This chapter explains how to administrate your 
system using the Administration window utilities.

Appendix A Setting Parameters This appendix describes how to set basic parameters 
in the Job Parameters window. It also describes the 
PPD file parameters.
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Overview of Spire CX250 Color Server
The Spire CX250 color server is an on-demand pre-press system that uses 
Creo Spire advanced pre-press technologies to drive a Xerox DocuColor 
240/250 printer-copier. 

As an optimal digital color solution for printers, the Spire CX250 color 
server enables you to print from Windows®, Macintosh®, and UNIX® 
client workstations. The Spire CX250 color server processes image files in 
page-description language (PDL) formats—for example, PostScript, PDF, 
and Variable Information—using RIP (Raster Image Processor) 
technology. The system converts image files into a suitable RTP (Ready-
To-Print) format for direct, high-quality digital printing. The Spire CX250 
color server also streamlines the printing process by allowing printing with 
preset workflows.

In combination with the Xerox DocuColor 240/250 printer-copier, the 
Spire CX250 color server enables you to efficiently print flyers, brochures, 
pamphlets, dummy catalogs, short-run trials, and print-on-demand 
publications. When installed as a fast, network printer with the Spire 
CX250 color server, the Xerox DocuColor 240/250 printer-copier prints 
up to 50 color or monochrome pages per minute.

The Spire CX250 color server combines RIP functionalities, automation, 
control tools and special hardware development capabilities with PC 
architecture.

Appendix B Reinstalling the System This appendix describes the software backup and 
restore, reinstalling the system, installing and 
configuring the Novell client, and formatting the 
image disk.

Table 2: Guide Overview

Chapter Contents Description
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Figure 1: Spire CX250 color server for Xerox DocuColor 240/250 printer-
copier—Spire CX250 with Pro configuration

Note:  The image above shows the Pro configuration. In the Control Station and 
Pro configurations, the Spire CX250 color server is mounted on the back of the 
stand.
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Hardware and Software Components
The Spire CX250 color server is a dedicated Creo platform running in a 
Windows environment. 

The Spire CX250 color server includes:

• Creo hardware, including the interface board

• Software, including:

Spire application software

Windows XP Professional

Adobe® Acrobat® version 6.0

Supported Formats
The Spire CX250 color server supports the following file formats:

• PostScript® (composite or pre-separated files)

• PDF

• EPS

• Creo VPS (Variable Print Specification)

• VIPP (Variable Data Intelligent PostScript Params)

• PPML (Personalized Print Markup Language)

• Creo CT & LW (these file formats are only supported if you have the 
Pro configuration)

• JPG, TIFF

• GAP (Graphic Art Port) files (file formats from various prepress 
systems, for example Brisque job and TIFF / IT) (this file format is only 
supported if you have the Pro configuration)

• Pre-separated formats (this file format is only supported if you have 
the Pro configuration)
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Workflow
The Spire CX250 color server receives and processes files from the 
following client workstations: 

• Macintosh – running Mac OS 9.x or later and Mac OS X (10.1 and 
later)

• Windows – running 2000, 2000 Pro, XP and 2003

• UNIX Workstations and Servers

The basic workflow for the Spire CX250 color server is as follows:
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Spire CX250 Color Server Network Printers
For Macintosh and Windows networks, the Spire CX250 color server 
provides three default network printers, also known as virtual printers.

Virtual printers are used for automating workflows, which then define job 
streaming. They contain preset workflows that are automatically applied to 
all print jobs processed with that virtual printer. There is no need to reset 
job settings for each job, thus increasing printing efficiency.

The three default virtual printers are:

• SpoolStore
Files are spooled directly to the Storage window and await operator 
processing. You can only import PDL files (such as: PS, PDF, VIPP, 
VPS) to the spool store, not RIPped - RTP files. 

• ProcessPrint
Files are processed and printed directly to the Xerox DocuColor 240/
250 printer-copier via the Spire CX250 color server.

• ProcessStore
Files are automatically processed and stored in RTP format. After 
processing, the files are stored in the Storage window of the Spire 
CX250 color server until the operator re-submits them for printing.

With printing workflows tailored to your job requirements, the Spire 
CX250 color server enables you to: 

• Define new virtual printers

• Choose from which virtual printer to print

Note:  The job (print) parameters set in the job (from the client) override the 
parameters set in the virtual printer. 

For information on defining and editing virtual printers, see Managing Virtual 
Printers on page 80.
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Overview
This chapter describes the main workflows and procedures for the Spire 
CX250 color server basic configuration.

Turning the Spire CX250 Color Server On and Off
To turn on the Spire CX250 Color Server (Basic Configuration):

Do one of the following actions:

Turn on the Xerox DocuColor 240/250 Printer-Copier.

The Spire CX250 color server turns on automatically when the 
Xerox DocuColor 240/250 Printer-Copier is turned on.

Press the green On/Off button on the front of the Spire CX250 
color server.

To turn off the Spire CX250 Color Server (Basic Configuration):

Do one of the following actions:

Turn off the Xerox DocuColor 240/250 Printer-Copier.

The Spire CX250 color server automatically turns off when the 
Xerox DocuColor 240/250 Printer-Copier is turned off.

Press the green On/Off button on the front of the Spire CX250 
color server.

Note:  The Spire CX250 color server can be turned on when the Xerox 
DocuColor 240/250 Printer-Copier is turned off. In this state, the server runs 
until turned off manually by the user. If the server is running and the printer 
is then turned on, the server continues running and is not affected by this 
action.
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Defining the Printer on the Client Workstation

To define a network printer using the Windows Add Printer wizard:

1. On your Windows desktop, click the Start button and select 
Settings>Printers and Faxes.

2. In the Printer Tasks area, select Add a printer.

The Add Printer wizard appears.

Note:  When you add a new Spire CX250 color server network printer to a client 
workstation, there is no need to install the Spire CX250 color server PPD file and 
Adobe PostScript printer driver separately. They are installed automatically in the 
Windows Add Printer wizard.



14  Chapter 2– Spire CX250 Color Server Basic Configuration Workflows

3. Click Next.

4. Select A network printer, or a printer attached to another computer 
and click Next.
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5. Select Find a printer in the directory, and click Next.

6. Locate the Spire CX250 color server and double-click to display the 
list of network printers.

7. Select the printer you want to setup, and click Next.

8. Select Yes if you want to set this printer as the default printer on your 
computer. Otherwise, select No.

9. Click Next.



16  Chapter 2– Spire CX250 Color Server Basic Configuration Workflows

10. Click Finish to close the wizard.

The Spire CX250 color server network printer is added to your printer 
list.

Setting the PPD Parameters
The PPD parameters can be accessed and changed from the client 
workstation. For information about the PPD parameters, see Setting 
Parameters on page 175.

Printing from the Client Workstation
You can print to the Xerox DocuColor 240/250 printer-copier from the 
client workstation.

Working from the Remote Desktop Application
The Remote Desktop Connection (RDC) utility enables you to connect, 
view, operate, and perform administrative procedures on the Spire CX250 
color server from a client workstation. While the remote connection and 
operation takes place, the regular operation of the Spire CX250 color 
server is not affected .

For more information, see Chapter 5, Printing From Your Computer.

Note:  This tool is designed exclusively for the system administrator. Users that 
want to connect to the Spire CX250 color server from a client workstation can 
use the Web Center to view and monitor jobs in the Spire CX250 color server 
queues.

For more information about viewing jobs from a client workstation, see Web 
Center on page 23.
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The Remote Desktop utility is integrated into the Windows XP 
Professional operating system, while for Windows 9x 98/ME, 2000, and 
Mac OS, the remote desktop must be set up. 

Connecting from Windows

To connect to the Spire CX250 color server from your client PC:

1. From your desktop select Start>Programs>Accessories>
Communications>Remote Desktop Connection. 

By default, the Remote Desktop Connection dialog box opens on the 
General tab.

For more information on installing the Remote Desktop utility on Windows 2000 
and earlier, see the Spire CX250 Color Server Technical Manual (Part Number 
731-00425A-EN).

Tip:  If the tabs are not visible, click Options.
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2. On the General tab, type the following information:

a. The name of the Spire CX250 color server to which you want to 
connect

b. The Spire local user name; the default is operator

c. The Spire local password; the default is spire

3. Select the Local Resources tab.

4. If you intend to install software via the remote desktop connection, in 
the Local devices area select the Disk drives check box.

5. Click Connect.

The Log On to Windows dialog box appears on the Spire CX250 color 
server.

Tip:  To shorten the connection process when a session to the selected remote 
computer disconnects, select the Save my password check box.
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6. Enter the User Name and Password, and click Connect.

You are now connected to the desired Spire CX250 color server. The 
shared drives on your client PC are published and appear locally on 
the desktop of the Spire CX250 color server. 

Connecting from Macintosh

To connect to the Spire CX250 color server from your Mac client:

1. Double-click the Remote Desktop Connection application. By default, 
the General tab appears.

If the workspace is not open on the Spire CX250 color server, see Opening the 
Spire CX250 Color Server Workspace from the Start Menu on page 29.

Note:  If the General tab does not appear, click the Options arrow to display 
the entire window.
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a. In the Computer box, type the name of the Spire CX250 color 
server to which you want to connect.

b. Type the Spire local user name and password.

User name is operator

Password is spire

c. Select the Add to Keychain check box. 

Note:  Selecting the Add to Keychain check box automatically saves 
your current connection settings, enabling a quick reconnection to the 
Spire CX250 color server. 
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2. Select the Display tab and verify that your settings are the same as the 
settings in the following window.
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3. Select the Local Resources tab.

4. If you intend to install software via the remote desktop connection, in 
the Local Resources tab select the Disk Drives check box.
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5. Select the Performance tab.

6. If you are connected via LAN, select the LAN (10Mbps or higher) 
setting.

7. Click Connect.

8. A security message appears, click OK.

The shared drives on your Mac client are published and appear locally 
on the desktop of the Spire CX250 color server.

Web Center
The Web Center is an Internet site that provides online information and 
can be accessed from client workstations.

The Web center enables you to view the status of jobs in the queues, the 
Messages window in its current state, and the printer system information.

If the workspace is not open on the Spire CX250 color server, follow the 
procedure for opening it. See Opening the Spire CX250 Color Server Workspace 
from the Start Menu on page 29.
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To connect to the web center from a client workstation:

1. On your desktop, click the Internet Explorer icon.

2. When the Internet Explorer starts, in the address field type: 
http://<host name>—for example, if the CX250 station name is 
CX250_12, type http://CX250_12.

The Spire CX250 color server Web Center appears. 

The Web Viewer
The Web Viewer page consists of three tabs and enables you to view the 
jobs that currently reside in the Spire CX250 color server Queues window 
and Storage window, and also view messages that currently appear in the 
Messages window. This information is important when you print from a 
client workstation because it enables you to monitor your jobs in the 
queues and then make any necessary changes. 

Important:  To connect to the Web Center from a client workstation, you must 
first enable the web connect service on the Spire CX250 color server, see 
Remote Tools Setup on page 148.

Note:  You can also use the Spire CX250 color server IP address—for 
example, http://192.168.92.10.

Important:  If you would like to connect to the Spire CX250 color server 
from a Macintosh client workstation, contact your system administrator to 
add the Spire CX250 color server name to the DNS. This is required since 
Windows name resolution protocols are not supported in Macintosh. The 
DNS addition is required when clients go through a main server on the 
network.
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In addition, if you have a system that uses XML protocol, you can retrieve 
information about the job list and printer status.

Web Viewer API
If you have a system that uses XML protocol, the JobList.xml file and the 
Printer Status.xml file enable you to retrieve information about the job list 
and the printer status.

The JobList.xml file contains information about files in the Print Queue, 
Process Queue, and the Storage window.

To see the Job List view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=JobList_xml.

The Printer Status.xml file contains information about the various printer 
states. To see the Printer State view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=PrinterStatus_xml.

Downloads
The Downloads page enables you to access the Spire CX250 color server 
Utilities folder and download available tools and files for Windows and 
Macintosh client workstations—for example, the Spire CX250 color server 
PPD file.

Table 3: Description of Web Viewer tabs

This tab Enables you to view

Queues Jobs that are currently running in the Spire CX250 color 
server Print queue and Process queue. 

Storage The Spire CX250 color server Storage window and the jobs 
that reside in this window.

Alerts The Spire CX250 color server Messages window. For 
example, if a job that you sent to print from your client 
workstation has failed—you can view the message in the 
Message window, edit the job parameters (PPD file), and 
then resend it for processing and printing on the Spire 
CX250 color server.

Printer Shows the Spire CX250 color server system information.
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Calibrating 
You can calibrate the Xerox DocuColor 240/250 printer-copier using the 
scanner calibration method. Access the Spire CX250 color server via the 
Remote Desktop Connection, and then follow the scanner calibration 
method as described in Scanner Calibration on page 109.

Scanning
You can set up scan boxes, and use the remote scan application to 
download and save scans you made on the Xerox DocuColor 240/250 
printer-copier. For information on using the remote scan application, see 
Remote Scan Application on page 73. 
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Turning On the Spire CX250 Color Server (Control 
Station and Pro Configurations)

If you have the Control Station or Pro configurations, perform the 
following procedure to turn on the Spire CX250 color server: 

1. Turn on the monitor.

2. Do one of the following actions:

• Turn on the Xerox DocuColor 240/250 Printer-Copier.

The Spire CX250 color server turns on automatically when the 
Xerox DocuColor 240/250 Printer-Copier is turned on.

• Press the green On/Off button on the front of the Spire CX250 
color server.

The power indicator on the front panel lights up. The Windows 
operating system starts, and the Spire CX250 color server splash screen 
appears.  

If you have the basic configuration, follow the procedure for turning on the 
Spire CX250 color server on page 12.

Note:  The Spire CX250 color server can be turned on when the Xerox 
DocuColor 240/250 Printer-Copier is turned off. In this state, the server 
runs until turned off manually by the user. If the server is running and 
the printer is then turned on, the server continues running and is not 
affected by this action.

Notes:

• If the Spire CX250 color server is already turned on, open the workspace 
from the Start menu.

• By default, the Auto Log On check box is selected in the Settings 
window. This option enables you to open the workspace without having 
to go through the logon process each time. If you want to designate 
different access levels for each user, you need to set security settings in 
the Settings window. For more information about designating access 
levels, see Security on page 149.
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If you are turning on the Spire CX250 color server after a reboot, a test 
page is automatically printed. By default, this test page is printed each time 
the Spire CX250 color server is restarted. 

The test page displays details about the Spire CX250 color server, the 
Xerox DocuColor 240/250 printer-copier, and the network setup.

Opening the Spire CX250 Color Server Workspace from the 
Start Menu

If the workspace has been closed, open it as follows:

Select Start>CX250>CX250.

The splash screen appears followed by the Spire CX250 color server 
workspace.

For more information about changing settings for the test page, see General 
Defaults on page 158.
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The Workspace

Table 4 describes the Spire CX250 color server workspace.

1

2

3

4

5

6

7

8

Table 4: Spire CX250 color server workspace

Item Name Description

1 Menu Bar Consists of the Job, Selection, Tools, Control, View, and Help menus. 
Click a menu name to open the corresponding menu.

2 Status Panel Contains the logo, Processing status area, Printing status area, server 
icon, printer icon, and current time.

For more information on the server and printer icons, see The Server 
and Printer Monitors on page 32.

3 Toolbar Consists of shortcut buttons for the Import window, Resource Center, 
Message Viewer, and Calibration window
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Customizing the Workspace View

4 Queues Consists of the Process Queue, which lists the files to be processed. After 
a file has been processed successfully, it moves to either the Print Queue 
(the upper area) or the Storage window.

For more information on Queues, see Managing the Job Queues on 
page 33.

5 Alerts Lists the alert messages that are generated during the workflow.

For more information on the Alerts window, see The Alerts Window on 
page 169.

6 Thumbnail Displays a thumbnail view of a specific page in an RTP job that has 
finished processing

7 Storage The Storage window contains files that:

• were successfully printed

• were held, were aborted, or failed during processing or printing

• were sent directly from the client workstation to the Storage window 
or were imported to the Storage window

For more information on the Storage window, see Managing the Storage 
Window on page 42.

8 Paper Stocks Displays information about the paper in each tray and also shows 
whether the trays are ready for printing.

NOTE: This window is only included in Classic Plus view. For more 
information, see Customizing the Workspace View on page 31.

Table 4: Spire CX250 color server workspace

Item Name Description
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The View menu enables you to customize the workspace. From this menu, 
you can open and close the Queues window. The menu also provides the 
following view options:

• Spire classic view: Displays the status panel, toolbar, Storage window, 
Queues window, Thumbnail window, and Alerts window

• Spire classic plus view: Displays the status panel, toolbar, Paper Stocks 
window, Storage window, Queues window, Thumbnail window, and 
Alerts window

• Queues view: Displays only the Print Queue and Process Queue

• Refresh view: Reverts to the factory default view for the view that is 
currently displayed

The Server and Printer Monitors

The server and printer icons are on the right end of the status panel and 
indicate (through animation) whether processing and printing are taking 
place. If a finishing device is connected to the printer, the finishing device 
also appears in the printer icon. You can click the printer or server icon to 
display status information. You also view messages regarding the printer 
operation mode and status next to the printer icon. 

Note:  The Spire CX250 color server always displays the workspace in the most 
recently selected view.

Tip:  By default, the windows in the workspace are all docked-that is, attached 
to the workspace. You can detach, or undock, a window from the workspace by 
right-clicking the window’s title bar and selecting Undock Window.

Server icon Printer icon
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Managing the Job Queues
After entering the Spire CX250 color server, a job resides either in the 
Queues window or in the Storage window, depending on the job flow. 

To display the Queues window:

From the View menu, select Queues.

The Queues window consists of two areas, the Process Queue and Print 
Queue.

• The Process Queue lists the job that is currently being processed and 
the jobs that are waiting to be processed. 

• The Print Queue lists the currently printing job and the jobs that were 
processed successfully and are waiting to be printed. The Print Queue 
also lists frozen jobs (jobs for which the specified paper stock is not 
available).

Each queue holds jobs in the order in which they enter it. At any time, you 
can view information regarding the number and status of the jobs in the 
queues. You can also change the order of the jobs and suspend or resume 
the queue.

After you start the Spire CX250 color server, the Queues window is 
displayed. The Queues window consists of the Print Queue and the Process 
Queue.
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Each queue holds jobs in the order in which they enter it. The top job in the 
queue is currently running, while all others are waiting to run. 

If necessary, you can change the order the jobs that are waiting in the 
queues. You can also view and edit the jobs’ parameters.

The Queues Window
After you submit PDL jobs (or resubmit PDL jobs), the Process Queue lists 
the files to be processed. 

Once a file has been processed successfully, it moves to the Print Queue and 
waits to be printed or to the Storage window (depending on the current job 
flow or virtual printer).

Note:  If there are very short jobs in the Print Queue, several jobs may be 
running at the same time. The jobs marked as running are listed first and printed 
in the order they are listed.

For more information about operations on the jobs residing in the Queue 
Manager, see Aborting a Running Job on page 39.
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The Queues window lists informations about the jobs that are being 
processed. Status indicators indicate the status of each job. Table 5 
describes the status indicators used in both the Process Queue and Print 
Queue.

Right-click the column heading row to select the columns that you want to 
view.

Table 5: Process Queue and Print Queue status indicators

This Status 
Indicator

Indicates This:

The job is running.

The job is frozen and held in the Print Queue. If a job 
is frozen, it indicates that the selected paper stock is 
not available.

The job is waiting.

Table 6: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

Job Type File format of the PDL job—for example, PS 
(.ps), PDF(.pdf), VPS(.vps)

Sender User name of the system from which this file 
originated

Submitted Date and time this job was first submitted to 
the Spire CX250 color server

Pages Number of pages to be processed in a PDF 
job. If the DTP application supported it, the 
number of pages is indicated for other PDL 
jobs

Sets Number of copies to be printed

Page Size Page size

Media Type Media type
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Status Information

The Processing and Printing status areas contains the following:

• The suspend and resume buttons (for more information see 
Suspending and Resuming Queues on page 38)

• The queue name.

• If a job is currently being processed or printed, the name of the job and 
a process indicator are displayed.

• The number of jobs in the queue—for example, 2.

Image Quality Image quality

File Size File size of the job

Account Account name taken from the Job info 
parameter

Job Info Job info type taken from the Job info 
parameter

Imposition Type of imposition used

Page Exception Whether or not the job has page exceptions

Server Name of the server being used

Virtual Printer 
Names

Name of virtual printer being used

Table 6: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

The Processing status area indicated the total number of pages for PDF jobs. 
The number of pages is indicated for other PDL jobs only if the desktop 
publishing application in which they were created supports this feature.
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Batching Jobs
The job-batching workflow combines jobs with similar attributes into a 
single batch to enable the printer to print the jobs continuously without 
pausing. This feature saves printing time, especially for a large number of 
small jobs. Jobs that use paper of the same size and weight are suitable for 
batching. 

When a job enters the Print Queue, the Spire CX250 color server checks 
whether the job is suitable for batching with the previous one. 

• A job that can be batched appears with the running status indicator 

. The printer prints both jobs without pausing between them. 

• A job that cannot be batched with the previous one waits in the queue 
and appears with the waiting status indicator . It is printed only 
when the printer finishes the previous job and comes to a stop. 

The Spire CX250 color server batches suitable jobs only if they are 
consecutive in the queue. Two jobs are not batched if a job that is not 
suitable comes between them in the queue.

The following types of jobs cannot be combined into one batch:

• Collated jobs and uncollated jobs

• Jobs that use different output trays

• Jobs with different staple positions

The job batching option is active by default. 

To deactivate job batching:

In the Settings window (Tools>Settings), select Preferences>Print 
Queue Manager>Disable Job Batching. 

For more information about job batching, see Print Queue Manager on 
page 160.
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Changing the Order of Jobs in the Queues 
You can rearrange the jobs in a queue to change the order in which they 
will be processed or printed. This feature is useful when you have an urgent 
job that takes priority, for example.

To move a job up in the queue:

Right-click the job and select one of the following options:

Promote: to move the job up one step

Promote to top: to move the job to the top of the queue

To move a job down in the queue:

Right-click the job and select one of the following options:

Demote: to move the job down one step

Demote to bottom: to move the job to the bottom of the queue.

Suspending and Resuming Queues
If necessary, you can stop a queue temporarily and then later continue its 
operation afterwards. To do this, use the suspend and resume buttons:

To suspend a queue:

Click the suspend button .

The button turns red (suspend mode), and the processing/printing 
stops after the current job has finished running.

Note:  You can only move one job at a time.

Note:  The job is placed below the Running job.
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To resume a queue:

Click the resume button .

The button turns green (resume mode), and the top job in the queue 
starts processing/printing.

Aborting a Running Job

To stop processing or printing a running job:

Right-click the running job in the Queues window, and from the 
menu, select Abort.

The job moves from the queue to the Storage window, and the Alerts 
window is updated.

The Aborted status  is assigned to the job, and the next job in the 
queue starts running.
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To return a job to the Process Queue or Print Queue:

Right-click the job in the Storage window and from the Job menu 
select Submit.

Moving a Waiting Job to the Storage Window
To the postpone processing or printing of one or more waiting jobs, use the 
Move to storage option.

To move a waiting job to storage:

1. Select the job in the Queues window.

Note:  To return a job to the proper queue, right-click the job(s) in the Storage 
window and from the Job menu select Submit.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.
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2. Right-click the job(s), and select Move to storage.

The job(s) move(s) from the queue to the Storage window and appears 
with the held job indicator . 

To return a held job from the Storage window to its original queue:

Right-click the job, and from menu select Submit.

The job moves from the Storage window to the queue and appears with 
the waiting job indicator.

Viewing and Editing Job Parameters 

In the Queues or Storage window, double-click the job whose 
parameters you want to view.

The Job Parameters window appears.

Note:  In the Queues window, you can edit the parameters of jobs that have 
not begun to run. If you want to edit the parameters of a running job, you 
must first suspend the queue (click the suspend button).

Note:  If you edit the parameters in of a job in the Print Queue and the 
changes require re-RIPing of the job, it automatically moves to the Process 
Queue.
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Deleting a Job
Once you delete a job from the Process Queue, Print Queue, or Storage 
window, you need to resubmit it for processing and printing. To 
temporarily remove a job from a queue, use the Move to storage option 
(see Moving a Waiting Job to the Storage Window on page 40).

To delete a job:

1. Right-click the desired job in the queue or Storage window, and select 
Delete.

The following message appears.

2. Click Yes.

The selected job is deleted.

Managing the Storage Window
The Storage window is displayed by default. If you close the Storage 
window, you can reopen it by selecting Storage from the View menu.

The Storage window contains jobs of various types:

• Printed Jobs

• Jobs that you moved to the Storage window or aborted during 
processing or printing

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.

Note:  You can delete more than one job at a time: Select the jobs, and from 
the Job menu, select Delete.
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• Jobs that failed during processing or printing

• Retrieved jobs

• Jobs that were imported directly to the Storage window from the client 
workstation (by selecting the Spool & Store option for the job flow)

In the Storage window, you can see the number of jobs that are in storage 
and their status.

Each job in the Storage window is assigned a status as shown in Table 7:

By default, the Storage window shows all the jobs, whatever their status. All 
the status buttons are selected—that is, they appear pushed in. If you click 
a status button—for example, the Completed Jobs button—the button is 
released and the list hides all the completed jobs:

Table 7: Storage window status buttons

Icon Status Indicates This

Completed The job has finished printing.

Held You moved the job from the Queues window 
to the Storage window; or the current job 
flow or virtual printer moved the job to the 
Storage window automatically.

Failed The job failed during processing or printing.

Aborted You aborted the job in the Queues window 
while the job was running.
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If you click the Completed Jobs button again, the button is pushed in and 
the list shows the completed jobs.

Discarding RTP Information
The RTP information can be discarded if desired. Under some 
circumstances, it is necessary to discard RTP data—for example when you 
want to re-RIP a file, archive a job without the RTP information, or edit 
tabs.

To discard RTP information from a job:

In the Storage window, right-click the relevant job and select Revert to 
source.

The RTP data is discarded and the file returns to its original format—
for example, PostScript.

Note:  When all the status buttons are in the released (unselected) position, The 
Storage window shows no jobs.
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Handling Jobs in the Storage Window
In the Storage window you can perform the following actions:

• Submit a job. See Submitting Jobs on page 45.

• Preview and edit a job, using the Job Editor. See Job Editor on page 63.

• View and edit the parameters of a job. See Viewing and Editing Job 
Parameters on page 41.

• Archive a job. See Archiving and Retrieving Jobs on page 46.

• Duplicate a job. See Duplicating Jobs on page 45.

• Delete a job. See Deleting a Job on page 42.

• View a job’s history (in the Job History window). See Viewing a Job’s 
History on page 48.

• Export a job as a PDF file.

• View the job ticket report for a job. See Job Ticket Report on page 101.

• View the preflight report for a job. See Preflight Report on page 103.

Submitting Jobs
In the Storage window, right-click the job, and select Submit.

RTP jobs are submitted to the Print Queue; all other jobs are submitted 
to the Process Queue.

Duplicating Jobs
1. In the Storage window, right-click the job and select Duplicate. 

A warning message appears.

2. Click Yes to continue. 

The selected file is duplicated and is given the name of the original job 
followed by the suffix _dup.

Notes:

• Duplicating an RTP job creates a PDL version of the job.

• Once you duplicate a job, you can only edit parameters in the Job 
Editor that do not require re-RIP. 
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Archiving and Retrieving Jobs
To keep enough disk space free, we recommend that you back up jobs and 
their related files to an external server and then delete them from the 
Storage window.

This backup process is called archiving. You can retrieve archived jobs and 
related files later for further use.

You can set a default archiving path that will automatically be displayed in 
the Open dialog box when you select Archive from the Job menu. Set this 
path in the Settings window under Preferences>General Defaults.

If a job includes VI elements, you need to archive or retrieve the VI 
elements before archiving or retrieving the job.

To archive a job on an external server:

1. In the Storage window, right-click the job you want to archive and 
select Archive.

The Archive dialog box appears.
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2. Locate the desired folder, and then click Archive.

A cabinet file (a compressed file) that contains all the files related to the 
archived job is created at the selected location. 

3. In the Alerts window, verify that archiving has been completed.

4. Delete the job from the Storage window.

To retrieve an archived job:

1. From the Job menu, select Retrieve from Archive.

The Retrieve dialog box appears.

Notes:

• The archived job retains its current status (that is, completed, failed, 
held, or aborted) and is archived with the information in its Job 
Parameters and Job History windows. 

• When retrieved, the archived job retains the original job name, not the 
name assigned when archived.
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2. Locate the archived job under its archive name, select the related 
cabinet file, and click Open. 

The selected job appears at the top of the list in the Storage window. It 
is assigned the status indicator (completed, held, failed, or aborted) 
that it had before archival. 

3. In the Alerts window, verify that the file has been successfully 
retrieved.

Viewing a Job’s History
In the Queues or Storage window, right-click the job and select Job 
History.

The Job History window appears.

Notes:

• You can retrieve more than one job at a time.

• The files related to the job (for example, PDL) are also retrieved.

• The job is retrieved with the information in its Job Parameters and Job 
History windows.

• The cabinet file is not deleted.

For more information about the Job History window, see Job History on 
page 171.
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The Settings Window

You can set all system preferences in the Settings window. 

To open the Settings window:

From the Tools menu, select Settings. 

The window is divided into two areas: 

• Administration: All users can view these settings, but only an 
administrator can configure the settings. 

• Preferences: All users can view these settings, but only an 
administrator or operator can configure the settings.  

Note:  If you log on to the Spire CX250 color server as a guest, the Settings 
window is unavailable.

For more information on the Settings window, see Chapter 8, System 
Administration.
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The Resource Center

The Resource Center enables you to add, remove, and manage external 
resources for the Spire CX250 color server.

To open the Resource Center:

On the toolbar, click the Resource Center button . 

The Resource Center provides access to the following resources:

• Profile Manager, see Profile Manager on page 125

• Fonts, see Managing Fonts on page 79

• Virtual Printers, see Managing Virtual Printers on page 80

• Imposition Templates, see User-Defined Imposition Templates on 
page 194.
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The Job Parameters Window
The Spire CX250 color server enables you to edit imported PDL files and 
change the job settings—for example, paper size, imposition, and color 
settings—in the Job Parameters window.

To open the Job Parameters window:

Double-click a job in the Storage or Queues window.
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The Job Parameters window title bar displays the following information:

• The name of the job

• The time of submission

• The name of the virtual printer

Table 8: Description of tabs in the Jobs Parameters window

This tab Enables you to

Print Settings Set print related job parameters—for example, 
Print range and Print method. See The Print 
Settings Tab on page 176.

Paper Stock Set job parameters related to Paper size and 
Media Type. See The Paper Stock Tab on page 179.

Print Quality Set job parameters related to print quality—for 
example, Trapping and Image quality—and 
improve the quality of printed jobs. See The Print 
Quality Tab on page 181.

Color Apply last minute color corrections, or set the 
output job to match other output devices. See 
Color Workflow on page 107 and The Color Tab on 
page 183.

Imposition Set job parameters related to positioning, folding, 
trimming, and binding of pages—for example, 
Margins and Template. See The Imposition Tab on 
page 191.

Services Set job parameters that will assist your job 
workflow—for example, APR path and Preflight. 
See The Services Tab on page 198.

Finishing Select from various options to finalize your 
printed document—for example, define settings 
for the front and back cover. See The Finishing Tab 
on page 203.

Exceptions Define paper sets to include special exceptions in 
a job, and add inserts or interleaves. See The 
Exceptions Tab on page 206.
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The Help Menu
The Help menu enables you to access the online help, which is based on 
this user guide, and provides information about the current version of the 
Spire CX250 color server installed on your computer.

To open the About window:

From the Help menu, select About.

The About window displays the following information:

• Spire CX250 color server version number

• Date the version was installed

• Any updates that were installed on top of the version

To open the online help:

From the Help menu, select Topics.

The DFE Monitor
To open the DFE Monitor window, click the server icon.

The DFE Monitor window displays information about disk space, network 
details, and the virtual printers you have defined. 

The Disk Usage tab shows how much space is available on the user disk and 
printer disk.
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The Network tab provides information about the network.

The Virtual Printers tab lists the virtual printers that you have defined.

The Printer Monitor
To open the Printer Monitor window, click the printer icon.
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The Printer Monitor window displays information about the size and type 
of paper in each tray, the connected devices, and other aspects of the 
consumables.

The Paper Stock tab displays information about the paper in each tray and 
also shows whether the trays are ready for printing.

The Finisher tab displays information about finishing devices that are 
connected to the Xerox DocuColor 240/250 printer-copier.
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The Consumables tab displays the status of other refillables.

Remote Desktop
The Remote Desktop utility enables you to connect, view, operate, and 
perform administrative procedures on the Spire CX250 color server from 
a client workstation. While the remote connection and operation takes 
place, the regular operation of the Spire CX250 color server is not affected. 

Note:  This tool is designed exclusively for the system administrator. Users that 
want to connect to the Spire CX250 color server from a client workstation can 
use the Web Center to view and monitor jobs in the Spire CX250 color server 
queues.

For more information the Remote Desktop application, see Working from the 
Remote Desktop Application on page 16.
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Shutting Down the Spire CX250 Color Server

Closing the Spire CX250 Color Server Workspace
In the Spire CX250 color server workspace, from the Job menu, select 
Exit Workspace.

The Spire CX250 color server workspace closes, and you return to the 
Windows desktop.

Closing the Spire CX250 Color Server
1. In the Spire CX250 color server workspace, from the Job menu, select 

Exit.

The Spire CX250 color server workspace closes, and you return to the 
Windows desktop.

2. Verify that the Spire icon has disappeared from the taskbar.

Note:  If there are jobs that are being processed or printed, a message is 
displayed.

Taskbar without Spire iconTaskbar with Spire icon
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Turning Off the Spire CX250 Color Server (Control Station 
Configuration)

Do one of the following actions:

Turn off the Xerox DocuColor 240/250 Printer-Copier.

The Spire CX250 color server automatically turns off when the 
Xerox DocuColor 240/250 Printer-Copier is turned off.

Press the green On/Off button on the front of the Spire CX250 
color server.

Turning Off the Spire CX250 Color Server (Pro Configuration)
Press the green On/Off button on the front of the Spire CX250 color 
server.

Note:  The Spire CX250 color server can be turned on when the Xerox 
DocuColor 240/250 Printer-Copier is turned off. In this state, the server 
runs until turned off manually by the user. If the server is running and 
the printer is then turned on, the server continues running and is not 
affected by this action.

Note:  The Spire CX250 color server can be turned on when the Xerox 
DocuColor 240/250 Printer-Copier is turned off. In this state, the server 
runs until turned off manually by the user. If the server is running and 
the printer is then turned on, the server continues running and is not 
affected by this action.
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Overview
You import jobs for printing in the following situations:

• When a page-description language (PDL) file is created on a client 
workstation that is not connected to the Spire CX250 color server

• When a PDL file is located on an external medium, such as a CD-ROM

• When the desired file resides locally on the Spire CX250 color server

Importing and Printing Files
To import files to the Spire CX250 color server:

1. From the Job menu select Import Job. 

The Import window appears. 
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2. To access the desired files, click the up one level button , or 
double-click on the file folders to go down the file tree.

3. In the upper list in the Import window, select the desired files and 

click the add button .  

The file(s) appears in the lower list.

4. Select a printer from the Virtual Printer list. 

5. Click Import.

All files currently listed on the lower list are sent to the Spire CX250 
color server to be processed and printed as defined in the selected 
virtual printer.

To check the status of imported jobs:

1. Click the Server icon arrow.

Note:  Use SHIFT or CTRL to select several files or CTRL+A to select all the files. If 
required, add the same file more than once. 

Notes:

• To remove a file, select the desired file in the lower list in the Import Job 
window and click the remove button.

• Use SHIFT or CTRL to select several files at once.
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The Importing/Retrieving window appears.

The Importing/Retrieving window indicates the name of the file being 
imported, its location and the job size. It also indicates the percentage 
of the job already transferred, both numerically and graphically.

2. Select one of the following options:

• Click Skip This Job to stop importing the current file and import 
the next job in the import queue.

• Click Abort All Jobs to stop importing all the files.

• Click Close to close the Importing/Retrieving window.

Reprinting Jobs

Submitting an RTP Job Requiring no Changes
Select the job in the Storage window and from the Job menu select 
Submit.

The job(s) are placed in the Print Queue.

Submitting a Job that Requires Re-RIPing
1. Double-click the job to open the Job Parameters window. 

2. Change the desired parameter and click Submit.

The Spire CX250 color server automatically determines if your job 
needs to be re-RIPed and places it in the appropriate queue.

Note:  Use SHIFT or CTRL to select several jobs.
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Job Editor
The Job Editor tool enables you to preview a job before printing, delete, 
move or insert pages. While you navigate to the various pages of a job, you 
can view thumbnails of the job. For an imposed job, you can view the 
imposed sheets, including the layout of the pages on each sheet. You can 
also view the pages’ orientation, crop marks, and fold marks.

To open the job editor:

In the Storage window, right-click an RTP job that you want to 
preview, and select Job Preview&Editor.

The Job Editor window appears, displaying the first page of the selected 
job. 

Navigation Buttons

The navigation buttons enable you to select a specific booklet or page to 
view, and to browse the pages of the current job.  

Note:  When the first page of a booklet is in view, the Previous Page navigation 
button takes you to the previous booklet. When the last page of a booklet is in 
view, the Next Page button takes you to the next booklet.
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Previewing the Job
The preview buttons enable you to switch the display mode of the page.

Table 9: Preview Buttons

This button: Enables you to:

Pan

View a different area of the image.

Eye Dropper

Find out the CMYK values of a specific area 
on the page. To find the values, first click the 
Eye dropper button. Then move the pointer 
to the point on the page where you want to 
measure the color values, and click. The 
CMYK values appear as a tool tip.

Zoom In

Magnify the selected area of the page.

Zoom Out

Reduce the size of the selected area by 50%.

One to One Zoom

View the actual size of the page one to one 
(1:1).

Fit to Screen

Scale the page to fit the available screen space.

View the image at different preset levels of 
magnification by selecting a percentage in the 
list.

Rotate View

Rotate the page by 90°, 180° and 270°.

Show/Hide 
Separation

Turn on or off one or more separations.
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Viewing Pages in the Job Editor
The Job Editor window has three tabs—Booklets, Thumbnails and 
Imposed Sheets—which enable you to switch between views.

The Booklets tab
The Booklets tab displays the booklets included in the selected job and the 
names and numbers of the pages in each booklet. The Booklets tab opens 
by default when you are previewing a nonimposed RTP job.

To view a page on the booklets tab: 

In the left pane of the Booklets tab, double-click the name of the page 
that you want to view.

The page is displayed in the right pane.
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The Thumbnails Tab 
The Thumbnails tab displays miniature views (“thumbnails”) of each page 
in the selected booklet. These thumbnails enable you to find a specific page 
more easily.

To view a page on the Thumbnails tab:

1. Click the Thumbnails tab.

Miniature versions of the pages appear on the left side of the tab, in the 
thumbnail pane.

2. Use the scroll bar, as desired, to view all of the pages.

3. To view the thumbnails side by side, resize the thumbnail pane by 
dragging the bar that divides the panes in the tab.

4. Double-click the thumbnail of the page that you want to view. 

The page is displayed in the right pane.
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The Imposed Sheets Tab

The Imposed Sheets tab is available only for imposed RTP jobs. This tab 
enables you to view the imposed sheets and check your imposition 
parameters. You cannot edit the job on this tab.

To display a page of an Imposed job:

1. Click the Thumbnails or Booklets tab.

2. Select the desired thumbnail or page.

3. Click the Imposed sheets tab.

The selected page of the imposed job appears.

Note:  The Imposed Sheets tab is available only if you have the Pro configuration.

Notes:

• In VI jobs, the booklet number appears in instead of the sheet number—for 
example, Booklet 1, Page 15.

• In duplex jobs, each sheet is displayed twice, once for side A, and once for 
side B. For example, Sheet 1, Side A.
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4. To edit the job, click the Booklets or Thumbnails tab. 

Editing an RTP Job
You can edit an RTP job in the following ways:

• Move pages within the job 

• Delete pages from the job 

• Insert pages from another job

To move a page in a job:

1. Click the Thumbnails tab.

2. In the thumbnail pane, click the page that you want to move.

3. Drag the page to the target location.

Note:  If you edit an imposed RTP job and then return to the Imposed sheet view, 
the view will be updated according to the applied changes.

Note:  Jobs that you can edit in the Job Editor cannot be re-RIPed. Once a job has 
been saved in the Job Editor, it is a new RTP file without an associated PDL file. 
You cannot apply parameters that require re-RIPing to such jobs.

Note:  The red marker indicates where the page will be inserted.
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The page moves to the selected location, and the page numbers are 
updated accordingly.

4. Click Save As to save the changes in the job.

To delete a page from a job

1. In the Job Editor window, click the page that you want to delete, and 
click Delete.

The page is deleted and the page numbers are updated accordingly.

2. Click Save As to save the changes.

Copying Pages Into a Job
You can copy one page or all pages from one job to another.

To copy a page into a job:

1. In the Job Editor window, click Select Job.

The RTP Jobs window appears.
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2. Select the job with the page you want to copy and click OK. 

Note:  The Spire CX250 color server displays only those RTP jobs that have 
the same page size and orientation as the job that you are editing.
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In the Thumbnails tab, the left pane splits into two. The thumbnails of 
the second job appear below those of the job you are editing.

3. In the lower set of thumbnails, locate the page that you want to copy.

4. Drag the page to the upper set of thumbnails, to the desired location 
in the job that you are editing.

Note:  The red marker indicates where the page will be inserted.
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The copied page is inserted in the desired location, and the page 
numbers are updated accordingly.

5. Click Save As to save the changes.

To copy all the pages of a job into another job:

1. Follow steps 1-4 in the procedure for copying a page into a job (see 
page 69).

2. Click the Merge Jobs button.

All the pages of the second job that you opened are inserted at the end 
of the job that you are editing.

3. Click Save As to save the changes.
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Remote Scan Application
Before you begin using the remote scan application:

• Enable remote scanning in the Spire CX250 color server Settings 
window (see Scan on page 167)

• Install the remote scan application on your client workstation. You can 
find the setup file, RemoteScan.exe, in the Utilities\PC Utilities on the 
Spire CX250 color server.

To open the remote scan application and connect to the Spire CX250 
color server:

1. From the Start menu, select Programs>Creo>Remote Scan 
Application>Remote Scan.

2. When you connect the first time, or to connect to a different Spire 
CX250 color server, enter the server hostname or IP address in the 
Server Name or IP list, and click Connect.

The remote scan application is connected to the Spire CX250 color 
server and you are ready to begin working. By default, the last scan box 
you used is displayed.

Note:  By default, the remote scan application remembers your last connection.
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The remote scan application enables you to:

• Create scan boxes either locally or from your client workstation, and 
then set parameters that specify the location of your scanned data, the 
format in which it is saved, and security settings

• Manage scanned images

The Spire CX250 color server has three default scan boxes:

• SpireBW200_1S—Jobs scanned to this box have the following settings: 
OutputColor=Black and white, ScanResolution=200dpi, 
2SidedOriginal=1 side

• SpireGrayScale200_1S—Jobs scanned to this box have the following 
settings: OutputColor=Greyscale, ScanResolution=200dpi, 
2SidedOriginal=1 side

• SpireColor200_1S—Jobs scanned to this box have the following 
settings: OutputColor=Color, ScanResolution=200dpi, 
2SidedOriginal=1 side

If you scan a job using one of the default scan boxes, the job is saved to the 
scan box, and to D:\PublicScans on the Spire CX250 color server.

Creating Scan Boxes
1. In the remote scan application, click ScanBox Manager.

Note:  There is a fourth default scan box for calibration.

Note:  The remote scan application must be connected to the server.
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The ScanBox Manager lists all the scan boxes that have been created. 

2. Click Add to add a new ScanBox.

3. In the Scan Box Name box, type a name for the scan box.

4. Select the Automatic Copy check box to automatically save a copy of 
the scanned job on your client PC.
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5. Do one of the following actions:

• In the Network Path box, enter the location to which you want to 
save the extra copy.

• Click Browse and browse to the desired location.

6. In the File Type box, enter the format in which you want to save the 
data that is saved to the scan box. The available options are JPEG, TIFF 
and PDF.

7. Select Security.

8. Select the Secure Scan Box checkbooks to secure the scan box, and 
specify a password.

9. Click Apply.

10. Select Scan Parameters.

Note:  The network browser that opens is local to the Spire CX250 color 
server.
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11. Select the desired output color from the OutputColor list.

12. Select the desired scan resolution from the ScanResolution list.

13. Select the desired print method in the 2SidedOriginal list.

14. Click Save.

The scan box is saved and appears in the ScanBox Manager.

Scanning Workflow
1. Position the original to be scanned in the Xerox DocuColor 240/250 

printer-copier.

2. On the Xerox DocuColor 240/250 printer-copier control panel, press 
the All Services button.

3. On the touch screen, touch Network Scanning.

4. Touch Refresh.

5. On the Basic Scanning tab, touch the name of the scan box that you 
want to save the scan to.

6. The Output Color and 2Sided Originals settings are selected according 
to the scan box settings. 

Note:  The output color cannot be changed during scanning.
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7. In the Basic Scanning, Image Quality, Scan Options and Output 
Format tabs, change the settings as desired.

8. Press the Start button.

The original is scanned. A beep is heard when the scan is complete. 
The scan is saved in the selected scan box with the name <scan box 
name>001 and with the relevant file extension.

Managing Scanned Images
Once a scan is performed, you can view the job using the remote scan 
application, or browse to D:\PublicScans on the Spire CX250 color server.

To view the scanned job from the scan box:

1. Open the remote scan application and ensure it is connected.

2. In the ScanBox list, select the scan box where the scanned job is saved.

All jobs scanned to the selected scan box are displayed.

3. Select the desired job, and click Save.

The Save dialog box opens.

Note:  The Output Color settings cannot be changed.
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4. Select a destination and click Save.

You can now open and work with your scanned data.

To delete a scanned job from a scan box:

1. Open the remote scan application and ensure it is connected.

2. In the ScanBox list, select the scan box where the scanned job is saved.

3. Select the desired job, and click Delete.

The scanned job is deleted.

Managing Fonts

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Fonts.
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3. Choose a Font Library option. The default option is Latin.

4. To set the default font, select a font from the list, and click Set as 
Default.

5. To delete a font, select the font, and click Delete font.

Managing Virtual Printers
A virtual printer is a printer published on the network with specific 
parameters set for processing and printing on the Spire CX250 color 
server. The Spire CX250 color server contains a mechanism that 
automatically installs the published virtual printers on your client 
workstation with the PPD and suitable printer driver. 

Note:  To add new fonts to the Spire CX250 color server, copy the new 
fonts to the C:\CX250\General\RIP\fonts folder.
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The Spire CX250 color server is predefined with three virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and printed to the 
printer through the Spire CX250 color server.

• ProcessStore 
Files sent to this printer are automatically processed and stored in the 
Storage window of the Spire CX250 color server. You can later submit 
the jobs to be printed, or change the parameters of a job and resubmit 
it for processing.

• SpoolStore
Files sent to this printer are automatically stored in the Spire CX250 
color server's Storage window until the print operator submits them 
for processing and printing.

If a job that is sent from the client, or downloaded to a particular virtual 
printer, contains preset parameters from the PPD, these options overwrite 
the parameters set in the virtual printer for that job. The Printer Default 
options defined in the PPD use the default parameters set for that 
particular virtual printer.

Adding a New Printer
When adding a new virtual printer you can specify if it is published on the 
network and if the virtual printer parameters will override the PPD 
parameters.

To add a new printer:

1. On the toolbar, click the Resource Center button . 

The Resource Center window opens.

2. From the Resource list, select Virtual Printers.
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3. Click the New button .

The Add Virtual Printer dialog box appears.

4. In the Name box, type a name for the new printer you want to add.

5. From the Based on list, select an existing printer with similar settings.

6. In the Comments box, type any comment regarding the virtual printer 
parameters (optional).

7. The Publish the printer on the network check box is selected by 
default. Clear the check box if you do not want to publish the printer 
on the network.
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8. Select the Override PPD parameters check box if you would like the 
virtual printer settings to override the PPD parameter selection.

9. Edit the job parameters of your new virtual printer. 

10. Click OK in the Add New Virtual Printer dialog box. 

The new printer appears in the Printer list.

Editing an Existing Printer

To edit an existing printer:

1. In the Virtual Printers area, select a printer from the list and click the 

Edit button .

2. Click Edit.

The Job Parameters window appears.

3. Select the desired parameters and change their settings according to 
your requirements.

4. Click OK to return to the Edit Virtual Printer dialog box.

5. Click Save to save the new settings.

Note:  If you don't edit the job parameters, the settings of the new virtual 
printer are taken from the printer on which it was based.
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Deleting an Existing Printer
1. In the Virtual Printers window, select a printer from the list and click 

the Remove button .

2. In the message that appears, click Yes to delete the designated printer.
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Overview 
To print a job from a client workstation, print the job to one of the Spire 
CX250 color server network published printers—for example, 
ProcessPrint.
The job is spooled and then processed and printed (according to the 
selected job flow of the published printer). If you use this method, you can 
print from any application —for example, Microsoft Word— and use any 
file format from any client workstation (Windows, Macintosh, or UNIX).

Working From Windows Client Workstations
The Spire CX250 color server can receive print jobs from client 
workstations with one of the following Windows operating systems:

• Windows 2000

• Windows XP

• Windows 2003

As an example, the following section describes how to define a Spire 
CX250 color server network printer for a client workstation with an 
Windows XP Professional operating system.

Note:  Jobs that are spooled to the Spire CX250 color server must have the 
appropriate file name extensions—for example, *.ps or *.pdf.

For information on defining a network printer using the Windows Add Printer 
wizard, see Defining the Printer on the Client Workstation on page 13.
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To define a network printer in Windows XP using the network 
neighborhood:

1. On the desktop, double click My Network Places and browse to the 
desired network printer.

2. Double-click on the network printer icon.

The network printer is defined on your Windows client workstation.

Copying the Printer Driver from Windows
Perform this procedure if your client workstation is not on the same 
network as the Xerox DocuColor 240/250 printer-copier and you want to 
create PostScript files.

1. In the D:\ drive, double-click the Utilities folder.

2. Click PC Utilities, and then Printer Driver.

3. Find the directory of the driver relevant to your version of Windows.

4. Using a compression utility, such as WinZip®, compress the directory, 
and either copy it to a disk or send it by email to the customer.
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Printing From Windows
1. Open the file you would like to print in the corresponding 

application—for example, open a PDF file in Adobe Acrobat.

2. From the File menu, select Print. 

The Print dialog box appears.

3. From the Name list, select the desired Spire CX250 color server 
network printer—for example, <servername>_ProcessPrint.

4. If desired, click Properties and modify the job parameters. 

5. Click OK.

6. Click OK in the Print dialog box.

The file is sent to the Spire CX250 color server. 

For more information abut setting PPD file settings, see Setting PPD File 
Parameters on page 208.

Notes:

• Unless the Override PPD Parameters option was selected in the 
published printer, any changes to the printer parameters override the 
parameters of the selected published printer. 

• Printer's Default indicates that the value is taken from the settings of 
the selected published printer on the Spire CX250 color server.
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Defining a Printer on Macintosh Client Workstations
You can submit jobs using the Spire CX250 color server published printers 
over a TCP/IP protocol. This connection enables a significantly higher 
spooling speed.

The Spire CX250 color server can receive print jobs from client 
workstations running Mac OS 9 and Mac OS X (10.3). As an example, the 
following section describes how to define a Spire CX250 color server 
network printer for a client workstation with a Mac OS X (10.3) operating 
system.

Copying the Spire CX250 Color Server PPD File for Mac 
OS X (10.3)
To print from your Macintosh computer to the Xerox DocuColor 240/250 
printer-copier, you first need to manually copy the Spire CX250 color 
server PPD file to the Macintosh. 

1. From the Go menu, select Connect to Server.

The Connect to Server dialog box appears.

2. Locate the desired Spire CX250 color server in the network and then 
double-click it.

3. In the Connect to Server dialog box, select Guest. 

4. Click Connect.

5. Select the Utilities volume, and click OK.

6. On the desktop, double-click the Utilities volume icon.

7. Double-click the PPD folder. 

8. Double-click the English folder.

9. Double-click the desired computer type folder—for example, MAC.

10. Double-click the desired location folder—for example, US-Letter.
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11. Locate the CX250_V1.PPD file. It is recommended that you copy the 
PPD file by dragging it to the specified folder in your local disk. To do 
this, open another Finder window.

12. From the Go menu, select Computer.

13. Click the MacOSX disk icon, and locate the required folder, for 
example: Library\Printers\PPDs\Contents\Resources\en.lproj.

14. Drag the CX250_V1.PPD file to the en.lproj folder.

Setting the Network Printer for Mac OS X (10.3)
You can define the network printer to use either the AppleTalk or TCP/IP 
protocol.

To set up using AppleTalk protocol:

1. Make sure that the Spire CX250 color server PPD file has been copied 
to the correct folder on your client workstation.

2. From the Go menu, select Applications.

3. Open the Utilities folder and then double-click Printer Setup Utility.

4. Click Add.

5. In the upper box, select Apple Talk.

6. In the lower box, select the required AppleTalk Zone from the list (as 
instructed by your system administrator).

7. Locate the Spire CX250 color server name in the list.

8. From the printers list, select <server_name>_ProcessPrint.

Any jobs sent to this printer will be automatically processed, printed, 
and stored.

9. In the Printer Model list, select Other.

10. In the Choose a File dialog box, double-click the folder to which you 
copied the PPD file: 
MACOSX\Library\Printers\PPDs\Contents\Resources\en.lproj.

11. Locate the CX250_V1.PPD file and double-click it.

For more information about copying the PPD file, see Copying the Spire 
CX250 Color Server PPD File for Mac OS X (10.3) on page 89.
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12. Click Add. 

You have successfully installed a network printer for the Spire CX250 
color server and are ready to start printing.

To use the TCP/IP protocol:

1. Make sure that the Spire CX250 color server PPD file has been copied 
to the correct folder on your client workstation.

2. From the Go menu, select Applications.

3. Open the Utilities folder and then double-click Printer Setup Utility.

4. Click Add.

5. In the upper box, select IP Printing.

6. In the Printer Type box, select LPD/LPR.

7. In the Printer Address box, enter the IP address of the printer.

8. In the Queue Name list, enter the printer model.

9. Click Add. 

You have successfully installed a network printer for the Spire CX250 
color server and are ready to start printing.

Printing from a Macintosh
1. Open the file you would like to print in the corresponding 

application—for example, open a Quark file.

2. From the File menu, select Print.

For more information about copying the PPD file, see Copying the Spire 
CX250 Color Server PPD File for Mac OS X (10.3) on page 89.
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3. From the Printer list, select the desired printer.

4. In the Copies & Pages list, select Printer Features.
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5. Adjust the printer options as desired.

6. After modifying the job settings, click Print.

The file is sent to the Spire CX250 color server. 

Remote Desktop
The Remote Desktop utility enables you to connect, view, operate, and 
perform administrative procedures on the Spire CX250 color server from 
a client workstation. While the remote connection and operation takes 
place, the regular operation of the Spire CX250 color server is not affected.

Viewing Jobs from the Web Center
The Web Center is an Internet site that provides online information and 
can be accessed from client workstations.

The Web center enables you to view the status of jobs in the queues, the 
Messages window in its current state, and the printer system information.

For information about the web center, see Web Center on page 23.

Notes:

• The Printer's Default option indicates that the value is taken from the 
published printer that is currently selected.

• The PPD parameters are divided into five Printer Specific Options in 
the list.

For information on the Remote Desktop, see Working from the Remote Desktop 
Application on page 16.
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Printing Reports from the Xerox DocuColor 240/
250 Printer-Copier

The following reports can be printed directly from the Xerox DocuColor 
240/250 printer-copier:

• Configuration—this report details the current Spire configuration. For 
more information, see View Configuration on page 165.

• Accounting—this report provides information about all the jobs that 
were printed successfully via the Spire CX250 color server. For more 
information, see Job Accounting on page 97

• Font List—this report lists the fonts that are available in the Spire 
CX250 color server. The font list is available on the Spire CX250 color 
server in the View Configuration utility. For more information, see 
View Configuration on page 165.

To print a report from the Xerox DocuColor 240/250 printer-copier:

1. On the Xerox DocuColor 240/250 printer-copier control panel, press 
the Machine Status button.

2. On the touch screen, touch Billing Meter/Print Report.

3. Touch Print Report/List.

4. Touch Extended Controller Jobs Report.

5. Touch the relevant report name:

• System Settings List to print the Spire Configuration

• Job History Report to print the Spire Accounting

• Font List to print the font list

6. Press the Start button.

The report is printed.

Note:  The Error History report is not supported in this version.
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Job Accounting
The Accounting feature provides information about all the jobs that were 
successfully printed via the Spire CX250 color server. The report is in the 
form of a tab-delimited file. You can filter, sort, and print the jobs in the 
report. You can also export the report to a spreadsheet application—for 
example, Microsoft Excel—where you can manipulate the data.

Setting the Accounting/Message Viewer
By default, all jobs that were handled during the past 90 days are listed in 
the Spire CX250 color server Accounting window. Also, all jobs that were 
handled during the past 56 days are listed in the Spire CX250 color server 
Message Viewer. You can specify how long information remains before 
being overwritten.

Viewing the Accounting Information
At any stage of work, from the Tools menu select Accounting.

The Accounting Viewer window appears, listing information related to 
all the jobs that printed successfully via the Spire CX250 color server. 

To change the Accounting/Message Viewer log setup, see Messages on 
page 163.
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Each row in the Accounting report contains information related to a 
specific job.

The columns indicate the following information:

Notes:

• To see additional columns, use the horizontal scroll bar.

• You can remove all the information from the window whenever desired.

Table 10: Description of columns in the Accounting Viewer

Column name Indicates the

Title Original name of the file related to this job (that 
is, without the file extension)

Job Size Job size in MB

Sender User name of the system from which this job 
originated

Started Process Date and time the job first started processing

Processing Time Total amount of time taken processing the job

Started Printing Date and time the job first started printing

Printing Time Total amount of time taken printing the job
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Exporting the Accounting Log 
You can save the Accounting information to an ASCII Tab delimited file.

To export the accounting information:

1. In the Accounting Viewer window, click Export.

The Export Accounting window appears.

Paper Size Size of the media set for the job—for example, 
Letter, A3, A4

Media Type Media type

B/W Pages Number of black-and-white pages in the 
original PDL file 

Color Pages Number of color pages in the original PDL file

Blank Pages Number of blank pages in the original PDL file

Purged B/W Number of B/W pages that were already in the 
paper path, and were cleared due to job abort or 
paper jam

Purged Color Number of color pages that were already in the 
paper path, and were cleared due to job abort or 
paper jam

Total Pages Number of pages that were printed

Account string of text that was entered in the Job 
Parameters [optional]

Recipient string of text that was entered in the Job 
Parameters [optional]

Job Comments string of text that was entered in the Job 
Parameters [optional]

Table 10: Description of columns in the Accounting Viewer

Column name Indicates the
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2. Locate the folder in which to save the report.

3. Click Save.

The log is saved as a Tab delimited text file in the specified location. 

4. If desired, open the *.txt file in a text editor or in a spreadsheet 
application—for example, Microsoft Excel—and manipulate the data.

You can print the Accounting information (filtered and sorted) to any 
connected printer.

Notes:

• The log includes all the columns (even those that were hidden), listed in 
the original order and sorting.

• To export specific rows, select them before clicking Export. The 
exported log will include only these rows.

• The exported data is not deleted from the Accounting report on the 
Spire CX250 color server (that is, it will still be displayed in the Job 
Accounting window).
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Printing the Accounting Log 
The Accounting log can be printed via the Spire CX250 color server or 
directly from the Xerox DocuColor 240/250 printer-copier.

To print the accounting log from the Spire CX250 color server:

1. Filter and sort the report as desired.

2. Click Print List.

The Print window appears.

3. Set the printing options as desired and click OK.

The data is printed according to the current filtering and sorting.

Job Ticket Report
The Job Ticket report contains all information from the Job Parameters 
window (including Job Parameters window title bar data). The Job Ticket 
report presents the job parameters on a single sheet and may be exported 
or printed as a hard copy.

For the procedure for printing the Accounting log from the Xerox DocuColor 
240/250 printer-copier, see Printing Reports from the Xerox DocuColor 240/250 
Printer-Copier on page 96.

Note:  To print specific rows, select the desired rows now. The printed report 
will include only these rows.

Notes:

• To fit the maximum amount of columns on the page, print using 
Landscape orientation (if your printer supports it).

• The report includes all the columns (including those that were hidden), 
listed in the original order.
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This feature is useful for:

• Updating the Hot-Line service on Job Ticket Report data when a 
question arises.

• Retaining job parameters when the same job is planned to be re-
printed in the future.

• Providing the client/customer a follow-up tool regarding printed Job 
Parameter information.

To display the job ticket report:

1. Right-click a job in the Storage window, and from the menu select Job 
Ticket Report.

The Job Ticket Report window appears.

2. You can export or print the report by clicking Print or Export.

The Job Ticket Report is exported as a text file.
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Preflight Report
The preflight report is a job-related report that provides information 
about the status (missing or found) of key job components prior to 
printing and enables you to correct your files accordingly.

It is especially useful to run the preflight check before you print a complex 
job with a large quantity of pages or copies. The preflight check detects the 
missing job components and displays them all at once in the Preflight 
Report dialog box. You can review the report and handle the missing 
components and thus save printing time.

If you run a preflight check, and all key components are found, the job is 
processed and printed according to the job flow you have selected. If the 
test fails (missing key elements are detected), the job is returned to the 
Storage window with the preflight report available for inspection.

The preflight report always reflects the last preflight run, if more than one 
preflight check is run on a job, the latest preflight report overrides the 
previous. When a preflight report is produced, the date and time of the 
preflight check are indicated in the Job History window.

To view the preflight report:

1. Right-click the job in the Storage window, and from the menu select 
Preflight Report.

The Preflight Report dialog box appears. If you selected the HiRes files 
option in the Preflight Options area, the HiRes Report appears first.

Note:  Since the Preflight Report dialog box lists all key job components (missing 
and found), you can choose to use this report to view the existing (found) key job 
components, for example the list of the existing fonts in a job, and their 
corresponding paths.
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If there are key components in the job not found, this will be indicated 

by the missing indicator  next to the HiRes, Spot Colors, and Fonts 
report options.

If you did not select a preflight option for the preflight check, the not 

preflighted indicator  appears next to the report option. 

If all of the files are found for a preflight option, the found indicator  
appears next to the report option.

2. From the Show list select one of the following options:

• To display all files, select All.

• To display only files that were found, select Found Only.

• To display only the missing files, select All Missing.
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3. Select the Spot Colors report option.

The Spot Colors Report area displays the missing spot color names 
(spot colors which were not found in the spot color dictionary) and 
the found spot color names (spot colors which were found in the spot 
color dictionary). The C,M,Y,K columns display the spot color CMYK 
equivalences:

If the status is missing the Spire CX250 color server uses the 
original CMYK values that are embedded in the PS file to emulate 
the desired spot color.

If the status is found the Spire CX250 color server uses the CMYK 
values that are in the spot color dictionary.
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4. Click the Fonts report option.

The Font Report area displays the name of the missing fonts that are 
not embedded in the file and do not exist in the Font Library and also 
the found fonts.

The Source column indicates whether the font is embedded in the file 
or was found in the Font Library.

5. To save the preflight report, click Save and browse to the desired 
location.

6. To print the report, click Print Report.

Tip:  If more than one preflight check is run on a job, the latest preflight 
report overrides the previous. If desired you may save the report for future 
use.
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Calibration Overview
One of the most important issues in obtaining satisfactory print quality is 
steady toner density. Toner density is affected by many factors such as 
heat, humidity, and service settings. You should perform a daily 
calibration to compensate for these factors. 

The calibration process corrects the printer colors by measuring their 
density and creating calibration look-up tables. The Spire CX250 color 
server uses the data in these tables to compensate for the differences 
between the actual, measured density and target levels; the target density.

You should perform calibration in the following instances:

• When you use a new paper stock

• At least once every eight hour shift for every combination of paper 
stock and screening method used

• When prints show “color casts”

• After machine maintenance or hardware changes—for example, 
replacing a photoreceptor

• On drastic ambient changes (temperature and humidity) 

There are two types of calibration:

• Scanner calibration, see Scanner Calibration on page 109

• Calibration using the X-Rite® DTP34 QuickCal densitometer (this 
option is available only if you have the Pro configuration), see 
Calibrating with the X-Rite DTP34 QuickCal Densitometer on page 112

Important:  Perform a different calibration for every combination of media and 
screen type you are going to use for printing. When calibrating, always use the 
same media that you intend to use for printing.
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Defining the Calibration Device
If you have the basic or Control Station configuration, you can only 
calibrate using the scanner calibration method.

If you have the Pro configuration, the default calibration mode is scanner 
calibration. If you want to calibrate using the X-Rite DTP34 QuickCal 
densitometer, set the calibration method to external device.

In the Settings window, set the Calibration Device option to use 
external calibration device.

Scanner Calibration
This section describes the scanner calibration process.

1. In the Spire CX250 color server application, from the Tools menu, 
select Calibration.

2. In the Calibration window, click Calibrate.

Note:  This option is available only if you have the Pro configuration. For more 
information, see Calibration Device on page 155.

Note:  

It is recommended that:

1. After you perform the first calibration, you print the IQ Test.pdf file from 
the D:\Shared\Sample Files folder. Each time you calibrate, use this file as 
a visual reference to verify that the printer has returned to its start point. 

2. You calibrate both the printer and scanner at the same time. If you only 
place the print chart on the platen, the printer is calibrated. If you only place 
the scanner chart on the platen, the scanner is calibrated.
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3. In the Tray list, select the desired tray. The default is Tray 1. You can 
print the calibration chart on any paper size that is equal to or larger 
than A4 or Letter.

4. In the Screening Method list, select the screening method.

5. In the Media Type list, select the media type that you are using for the 
print job. The default setting is Use Printer Settings. When this option 
is selected, your job is printed on the media type that is defined on the 
Xerox DocuColor 240/250 printer-copier.

6. In the Image Quality list, select the image quality type.

7. Select the Gloss Mode check box if you want to calibrate for glossy 
printing.

8. In the Number of copies box, enter the number of copies you want to 
print.

9. Click Print. 

The calibration chart prints.

10. Click Next.

Tip:  It is recommended that you print at least 10 copies of the calibration 
chart, and then use one of the last copies printed.
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11. On the platen glass of the printer, place the calibration chart and the 
scanner calibration chart next to each other, facing down.

12. On the Xerox DocuColor 240/250 printer-copier control panel, press 
All Services.

13. On the control panel's touch screen, touch Network Scanning.

14. On the Basic Scanning tab, touch the 001 Calibration scan box.

15. Touch the Image Quality tab.

16. Under Color Space, touch the Standard Color Space button to select 
the specific color space of the Xerox DocuColor 240/250 printer-
copier.

17. Touch the Device Color Space button.

18. Touch Save.

Note:  If you place only the calibration chart on the platen glass, the printer 
is calibrated. If you place only the scanner chart on the platen glass, the 
scanner is calibrated. It is recommended that you calibrate both the printer 
and scanner at the same time.
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19. To start scanning the charts, on the control panel, press Start.

The charts are scanned and measured and a calibration table is created. 
In the Spire CX250 color server Calibration Wizard, the software 
informs you whether or not the calibration was successful.

20. In the Calibration Wizard, click Finish.

If the calibration process is successful, two calibration tables are 
generated: 

• Normal: Maintains the gray balance throughout the range of colors 
in the print job file

• Saturated: Is the same as the normal table for 80% of the color 
range; but from that point on, each color has a greater density

Calibrating with the X-Rite DTP34 QuickCal 
Densitometer

The procedure for calibrating using the X-Rite DTP34 QuickCal 
densitometer consists of the following main steps:

1. Calibrate the densitometer, see Calibrating the X-Rite DTP34 QuickCal 
Densitometer on page 113.

2. Load the paper you are going to use for printing in the Xerox 
DocuColor 240/250 printer-copier.

3. Follow the Spire CX250 color server Color Calibration Wizard steps.

When the calibration is complete, print the job using the calibration 
table, see Printing the Job with the Calibration Table on page 124.

Note:  This option is available only if you have the Pro configuration.
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Guidelines for Successful Calibration
To ensure your calibration is as accurate as possible, check the following 
guidelines before you calibrate:

• Ensure that your X-Rite DTP34 QuickCal densitometer is connected 
properly

• Ensure that your X-Rite DTP34 QuickCal densitometer is calibrated. 
You should calibrate the device at least once a week, or whenever the 
power to the device is interrupted. Use the manufacturer calibration 
chart supplied with the device. After you finish calibrating the device, 
make sure you store the chart in the designated envelope. 

• To warm up the printer, use any media to print at least 25 duplex sheets 
of any four color test job.

• Print a reference job and use the same media and screen type on which 
you will print the final job. 

• Prepare the calibration pad to measure the calibration charts. If a 
calibration pad is not available, set a white media, at least 200 gsm, or 
two sheets of lighter paper, on the surface. Read the calibration chart 
on this surface.

• Set the Spire CX250 color server emulation method to the method you 
will use to print the customer job (Device Link).

Calibrating the X-Rite DTP34 QuickCal Densitometer
The X-Rite DTP34 QuickCal densitometer is a color measurement 
instrument that reports densitometer and dot data.

Perform the following steps before first time use of the X-Rite DTP34 
QuickCal densitometer:

• Familiarize yourself with the X-Rite DTP34 QuickCal Densitometer 
Operations Manual. 

• Connect the X-Rite DTP34 QuickCal densitometer.

• Calibrate the X-Rite DTP34 QuickCal densitometer.

You can also use the DTP34 Tutorial to learn how to use the X-Rite DTP34 
QuickCal densitometer correctly. Access the tutorial from 
Tools>Calibration, and then click Calibrate. In Step 1 of the Color 
Calibration wizard, click DTP34 Tutorial - Click & Learn.
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Connecting the X-Rite DTP34 QuickCal Densitometer to 
the Spire CX250 Color Server

Before calibrating the X-Rite DTP34 QuickCal densitometer, make sure 
that you perform the following steps:

• Interface the X-Rite DTP34 QuickCal densitometer directly with one 
of the computer's serial ports

• Quit all programs and shut down the computer before you install 
interface cabling

Plug the power supply into an AC wall outlet and connect to the X-Rite 
DTP34 QuickCal densitometer communication cable. The LED indicates 
a variety of instrument operation conditions, such as calibration mode and 
operation. 

PC
Db9

MAC
Mini-DIN 8

Power Input

Mini-Din 8 Plug

SE108-94-02
Interface Cable

SE108-DB9PA-01
(Optional)

Note:  Verify that the Mini-Din 8 Plug is firmly seated, and that you hear a click 
sound. The connector is spring loaded and must be properly seated.

For a complete list of all conditions reported by the LED, see the X-Rite DTP34 
QuickCal Densitometer Operations Manual.
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Calibrating the X-Rite DTP34 QuickCal Densitometer

Frequency of Calibration

Your X-Rite DTP34 QuickCal densitometer should have a quick 
calibration at least once a day. A full calibration should be performed 
annually, during heavy usage to provide accurate measurements, or if the 
quick calibration consistently fails. Typically, the host computer prompts 
for an instrument calibration (amber LED) when required, but the process 
can be invoked manually at any time. See the following procedure for 
information about the calibration process.

Positioning the Instrument on the Calibration Reference

Handle the reflection reference by the edges. Make sure that the reflection 
reference is free of dust, dirt, and smudge marks. To obtain the most 
accurate calibration, hold the instrument with consistent and nominal 
pressure during the calibration process.

Position the instrument on the designated location of the reflection 
reference (indicated by a dotted outline of the instrument). Do not move 
the instrument more than 0.25" (6.35mm) before reading the strip.

 

STATUS  X

DTP34-100   #:

X-Rite
Reflection Reference

C=  .XX

AXXXXXXXX-XXXXX  D:  XXX

M=  .XX Y=  .XX

R
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Quick Calibration
You can perform a quick calibration at any time. The only required action 
is to scan the reflection reference as you would with any other strip. You 
should only perform a quick calibration after a full calibration has been 
done. New densitometers are fully calibrated before leaving the factory.

1. Position the X-Rite DTP34 QuickCal densitometer on the reference   
as previously mentioned.

2. Press and click the button and scan the reference to the opposite end. 
Release the button. The LED should indicate green if the calibration 
was successful. If calibration fails (fast flashing amber LED), verify 
that the strip is clean and re-read.

3. Place the reflection reference in its protective envelope, and store the 
envelope away from light and heat.

Full Calibration

1. To manually invoke the calibration mode, press and hold the 
Instrument button for a minimum of three seconds. The LED slowly 
flashes amber when calibration is initiated.

2. Press and hold the button (if not previously held) and scan the 
reference to the opposite end. Release the button. The LED should 
indicate green if the calibration was successful. If calibration fails, (fast 
flashing amber LED), verify the strip is clean and re-read.

3. Place the reflection reference in its protective envelope, and store the 
envelope away from light and heat. 

Creating a Calibration Table
1. In the Spire CX250 color server application, from the Tools menu, 

select Calibration.

2. In the Calibration window, click Calibrate.

The Calibration Wizard window appears.

Note:  If the host computer initiated calibration (amber LED), skip to step 2.
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The first step in the wizard is Print Calibration Chart. This step enables 
you to detect the point where you start to see toner on the paper. 

3. In the Tray list, select the required input tray.

The default tray setting is Auto. When this option is selected, the 
wizard looks for a tray that contains Letter LEF or A4 LEF paper. If the 
wizard does not find a tray with either of these sizes, an alert appears.

You can print calibration charts on any size paper. Ensure that the 
required paper is in one of the trays, and then select that tray in the 
wizard.

4. In the Screening Method list, select the desired screening method.

5. In the Media Type list, select the desired paper stock type. The default 
setting is Use Printer Settings, which means that your job is printed 
on the media type that is defined on the Xerox DocuColor 240/250 
printer-copier.

Tip:  Click the Densitometer Tutorial - Click & Learn icon to display an 
animation of the measurement process and to learn how to use the X-Rite 
DTP34 QuickCal densitometer correctly.

Note:  Make sure you set the screening method to the one you are going to 
use to print the job.
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6. In the Image Quality list, select the desired image quality. The default 
setting is Use Printer Settings.

7. In the Gloss Enhanced list, select Yes to create a glossy finish on the 
chart.

8. Set the number of copies you need by typing the number or using the 
arrows next to the box to select the number.

9. Click Print.

The Start Point Density calibration is printed.  

10. Collect the chart(s) from the printer.

Step 2 of the Color Calibration Wizard appears. In this step you scan 
the start point chart so that the wizard can measure each separation 
and find the point at which the toner appears on the paper.

Note:  Since the performance of the Xerox DocuColor 240/250 printer-
copier is best after several pages have been printed, it is recommended that 
you print at least 10 copies of the first calibration chart and use one of the 
last copies printed.

Note:  If you selected Automatic as the Screening Method in Step 1 of the 
wizard, the Xerox DocuColor 240/250 printer-copier prints two charts, an 
Image Density Calibration Chart and a Text/Line Art Chart.
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If you selected Automatic as the Screening Method in Step 1 of the 
wizard, you need to calibrate the Spire CX250 color server using two 
charts. Step 2 of the Calibration Wizard appears as follows:
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11. While pressing down the button on the X-Rite DTP34 QuickCal 
densitometer, align the head with the cyan arrow’s tip. The arrow is to 
the left of the cyan column on the Image Density Calibration Curve. 
Its tip intersects the semi-dotted line.

12. Sweep the X-Rite DTP34 QuickCal densitometer over the cyan 
column.

A beep sounds and a green light blinks when the scan is complete. A 
check mark appears over the cyan icon and instructions appear for the 
next sweep, this time for the magenta column. 

13. After each color sweep, wait for the check mark to appear over the 
appropriate icon and follow the instructions as listed.

When all of the separation columns have been successfully scanned, a 
check mark appears next to all icons.

Step 3 of the Color Calibration Wizard appears. 

Note:  Ensure that the separation columns on the chart are scanned in the 
order they appear in the icons: Cyan>Magenta>Yellow>Black.

Notes:

• If at any stage the scanning has not been completed properly, click 
Reset and scan again.

• If an error occurs while you are scanning the chart, an alert message 
appears. Click OK and re-scan the charts.

• If you selected Automatic as the Screening Method in Step 1 of the 
wizard, repeat steps 11-13 for the Text/Line Art chart.
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14. Select Save as and select the required name for the calibration table. 
Type your own or select one from the list.
Or: 
Select As default table (Normal) to save the calibration table as 
Normal. 

Note:  Each time you save a calibration table as default, it is saved twice, once 
as Normal look up table, and once as the Saturated look up table. The Spire 
CX250 color server automatically overwrites the existing Normal and 
Saturated calibration tables.

Tip:  It is strongly recommended that you include the specific paper name and 
screen method in the calibration table file name. This helps you select the 
correct calibration table in the job setup.
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15. Click Finish. 

Regardless of the option you chose, two calibration tables are saved:

• Normal: A table that maintains the gray balance throughout the 
range of colors in the print job file

• Saturated: A table that is the same as the normal table for 80% of 
the color range but from that point on, each color has a greater 
density. You can use this table when you need dark colors that are 
more intense than in the normal table.

For example, if you name your Normal calibration table Tuesday23, 
the Saturated table is automatically named Tuesday23.sat.

Using Calibration Tables
From the Tools menu, select Calibration.

The Calibration window appears.
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The following options are available:

• Click Calibrate to run the Color Calibration Wizard. This wizard 
guides you in the use of the X-Rite DTP34 QuickCal densitometer to 
create calibration tables, see Creating a Calibration Table on page 116.

• Select a calibration table from the Calibration List and click Delete to 
delete the calibration table.

• Click Close to close the Calibration window.

Calibration List
The Spire CX250 color server uses calibration tables to compensate for the 
difference between the printer’s performance and the required values.

The following calibration look up tables are provided: 

• SpireNormal: Applies the factory default calibration table. Since this is 
a default lookup table, it cannot be overwritten. 

• SpireSaturated: Applies the factory default saturated calibration table. 
This look up table applies a darker calibration table in comparison to 
the SpireNormal look up table. Since this look up table is a default table 
it cannot be overwritten. 

• Normal: Initially the Normal look up table is identical to the 
SpireNormal look up table. This resemblance changes as soon as you 
calibrate your Spire CX250 color server, and at the end of the 
calibration process choose to save your calibration table as default. As 
a result, your calibration table is saved as the Normal look up table. 

• Saturated: Initially the Saturated look up table is identical to the 
SpireSaturated look up table. This resemblance changes as soon as you 
calibrate your Spire CX250 color server, and at the end of the 
calibration process choose to save your calibration table as default. As 
a result, your calibration table is saved as the Saturated look up table. 

• Select None if you do not want to apply a calibration table to the job.
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Printing the Job with the Calibration Table
Now that you have calibrated the paper you are going to use for printing, 
you can select the calibration table to print any job on the same paper stock 
using the same screen type. You can print the reference job you printed 
before with the new calibration table to evaluate the calibration results.

To print the reference job:

1. In the Spire CX250 color server workspace, suspend the Process 
Queue.

2. Import the job.

3. Double-click the job to open the Job Parameters window.

4. On the Paper Stock tab, select the desired paper stock.

5. On the Color tab, select the calibration you created for the particular 
stock from which you printed. 

6. On the Color tab, select the screening method you used for the 
selected calibration.

7. Set all other desired parameters, and then click OK to close the Job 
Parameters window.

8. Activate the Process Queue and Print Queue, and inspect the printed 
job.

If you see that the print out has any color imperfection, review the job 
parameter settings and make changes if necessary. If there are still color 
imperfections, perform machine maintenance and repeat the calibration 
process.

For more information about tabs in the Job Parameters window, see Setting 
Parameters in the Job Parameters Window on page 176.



Color Tools 125

Color Tools

Profile Manager

The Profile Manager enables you to import and delete source and 
destination ICC profiles, and map destination profiles to specific paper 
colors.

Source profiles are used to emulate other devices, or color spaces. You can 
import source CMYK or RGB profiles. To use a profile in a job, in the Job 
Parameters window, select Color>RGB workflow or Color>CMYK 
workflow>Emulation, depending on the profile you imported. 

Destination profiles define the color space of your printer and are based on 
the combinations of paper and toner that you are using. For different 
paper stocks, you need different destination profiles. Each custom 
destination profile will be used with coated and uncoated paper. To use a 
different destination profile in a job, in the Job Parameters window, select 
Color>Destination profile.

Managing Device Link Profiles

To import a source ICC profile:

1. On the toolbar, click the Resource Center button . 

The Resource Center opens.

2. In the Resource list, select Profile Manager.

Note:  The Profile Manager is available only if you have the Pro configuration.

For more information about selecting a source profile in a job, see RGB 
Workflow on page 185 and CMYK Workflow on page 185.

For more information about selecting a destination profile in a job, see 
Destination Profile on page 188.
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The Source Profile tab appears, and the predefined source ICC profiles 
are displayed.

3. Click the Import button .

The Import Source ICC Profile dialog box appears.

4. In the Source Profile area, click the browse button . Locate and 
select the required source profile, and then click Open.

The new emulation name is displayed in the Emulation Name box; if 
you would like to change the name you may do so.

5. Click Import.

The new source ICC profile is added to the Emulation (Device Link) list 
in the Job Parameters window, in the CMYK Workflow parameter or 
to the RGB workflow parameter. 
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To import a destination ICC profile:

1. In the Resource Center>Profile Manager, click the Destination Profile 
tab.

The predefined ICC profiles are displayed.

2. Click the Import button .

The Import Destination ICC Profile dialog box appears.

3. In the Source Profile area, click the browse button . Locate and 
select the required source profile, and then click Open.

The new emulation name is displayed in the Emulation Name box; if 
you would like to change the name you may do so.

4. Click Import.

5. If you would like to set the imported destination as your default, select 
it and click Make Default.
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To delete an ICC Profile:

1. In the Resource Center>Profile Manager, select the profile you would 
like to delete.

2. Click the delete button .

The profile is deleted from the profile list.

Spot Color Editor and Workflow
Individual job pages can contain continuous tone (CT), line work (LW), 
and spot color elements. The Spire CX250 color server Spot Color Editor 
enables the editing of CMYK values of every spot color in the Spot 
dictionary. You can edit these values without affecting the CT or LW page 
elements. It also enables you to create custom spot colors and to define 
fixed CMYK values for those spot colors. The Spire CX250 color server 
supports HKS and PANTONE 2000 Spot colors.

To edit an existing PANTONE color:

1. From the Tools menu, select Spot Color Editor.

The Spot Color Editor window appears with the Spire CX250 color 
server's entire collection of colors listed.

Note:  You cannot delete predefined ICC profiles.

Note:  Spot colors—for example PANTONE—are not effected by CMYK 
emulation. A spot color has the same appearance with any selected CMYK 
emulation.
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2. Search for a particular color under Color.

3. Alternatively, from the Spot dictionary list, select the color dictionary 
that contains the color you wish to edit.

4. Highlight the required color. 

The color's CMYK values and a color preview appear in the right hand 
side of the Spot Color Editor window.

5. Change the CMYK values as required.

6. Click Apply. 

The new color is added to the Custom color dictionary.

To create a new spot color:

1. In the Spot Color Editor window, click the New Color button.

The Spot Color Editor dialog box appears.

Note:  Under Color, you cannot perform an exact query. This input stream 
only reads one character. For example, you want “Cool Grey 4” and type 
“Cool“. As soon as you type “C”, the cursor only moves to “Cool Grey 1” 
and does not continue to a more specific selection. 

Note:  Use the PANTONE CV dictionary if you are working in QuarkXPress.
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2. Type the new color name as it exists in the PostScript file. 

3. Adjust the CMYK values as required.

4. Click OK. 

The new color is added to the Custom dictionary.

To delete a spot color (from the custom dictionary only):

1. From the Spot dictionary list, select Custom Dictionary. 

2. From the list of custom colors, select the color you wish to delete.

3. Click Delete.

The following message appears.

4. Click Yes to delete the color. 

Note:  The Spot color names are case sensitive and should match the name 
as it appears in the DTP application.
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Gradation Tool
Sometimes you need to perform tone corrections when printing a job. 
These changes in gradation can include brightness, contrast, and color 
balance adjustments throughout the tone range of an entire image, or in 
specific tone ranges. 

Gradation tables you create using the Gradation tool are added to the 
gradations list in the Color tab, and may be applied to print jobs. The Spire 
CX250 color server also enables you to visually check the effect of different 
gradation adjustments on RTP jobs prior to printing.

With the Spire CX250 color server Gradation tool, you can apply the 
default gradation table or another pre-configured gradation table to a job. 
You can also edit an existing table and save your changes. Gradation is an 
interactive function and changes are automatically applied to the displayed 
image.

The Gradation tool is used to create and edit gradation tables and to check 
the effect of different gradation adjustments on specific RTP jobs. These 
tables can then be applied to your jobs during job processing for tailored 
gradations.

To open the Gradation tool:

From the Tools menu, select Gradation.

The Gradation dialog box appears.

Preview 

Note:  You can edit an existing gradation table, but you can not overwrite the 
default gradation table, DefaultGradTable.

Notes:

• Gradation is an interactive function. Gradation changes are automatically 
applied to the displayed image.

• The gradation table created is not automatically applied to the previewed 
job. You must use job parameters to assign a gradation table to a job.
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To preview a job:

1. Click Browse to select a job for display in the Preview window. 

The Processed Jobs window appears. The jobs that are displayed are 
the RTP jobs listed in the Storage window.

2. Select the job you wish to preview, and then click Open.

The job appears in the Gradation dialog box.
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Editing Gradation Tables
When you open the Gradation Tool window, the default gradation table, 
DefaultTable, is selected in the Gradation Table list, and is displayed in the 
graph. This table serves as a baseline and consists of a 45° gradation curve, 
with Brightness and Contrast set to 0, and Contrast Center set to 50. All of 
the color separations are selected.

Gradation tables that you create also appear in the Gradation Table list. 
When you select a gradation table, the predefined settings are immediately 
applied to the processed job that you are working with.

The separations buttons enable you to select one, all, or any combination 
of separations to edit for a specific gradation table. Selecting a specific 
separation enables you to change the color balance for a specific tonal 
range.

When you open the Gradations Tool window, all of the separations are 
selected.

1. Click the All Colors button  to edit all the separations 
simultaneously.

2. Click the individual separations you wish to edit—for example, select 
the cyan separation only.

3. Click the curve in the graph to add a point, and then drag the point to 
modify the separation. When you select a point, its value appears in 
the Input or Output boxes.

The Input axis represents the tone values of the image before gradation 
changes. The Output axis represents the tone values of the image after 
gradation changes.

4. To view gradation changes in your job, click Refresh. Changes are 
automatically applied to the displayed image in the After view.

5. To remove a point on the curve, select the point and then click 
Remove.

6. To reset the gradation curve to a 45° curve, click the Reset button 

.

7. To revert to the original gradation settings, click Revert.
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8. To remove the last change you made to the gradation graph, click 
Undo.

Creating a New Gradation Table
1. In the Gradation Tool window, modify your gradation table as 

required.

2. Click the Save button . 

3. In the Table name box, type the required name for the new gradation 
table, and click OK. 

The gradation table is saved and added to the Gradation Table list and 
to the Color Modes tab in the job parameters window.

Deleting a Gradation Table
Select the gradation table in the Gradation Table list, and then click the 

Remove button .

Navigation Buttons

The navigation buttons enable you to select a specific booklet or page to 
view, and to browse the pages of the current job. 

Note:  You cannot delete the predefined gradation table.
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Using the Preview Tools
The preview buttons enable you to switch the display mode in the original 
and edited views.

Table 11: Preview Buttons

This button: Enables you to:

Pan

View a different area of the image

Eye Dropper

Find out the CMYK values of a specific area 
on the page. To find the values, first click the 
Eye dropper button. Then move the pointer 
to the point on the page where you want to 
measure the color values and click. The 
CMYK values appear as a tool tip.

Zoom In

Magnify the selected area of the page

Zoom Out

Reduce the size of the selected area by 50%

One to One Zoom

View the actual size of the page one to one 
(1:1)

Fit to Screen

Scale the page to fit the available screen space

View the image at different preset levels of 
magnification by selecting a percentage in the 
list

Rotate View

Rotate the page by 90°, 180° and 270°

Show/Hide 
Separation

Turn on or off one or more separations
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Brightness and Contrast Slider Controls
The Brightness and Contrast slider controls are active only when all of the 
separations are selected.

Brightness

Brightness increases or decreases the luminance of the image. Increasing 
brightness brightens the image and results in a concave curve. Decreasing 
brightness darkens the image and results in a convex curve. 

Move the Brightness slider to the right to increase brightness or to the 
left to decrease brightness.

Contrast

Contrast increases the image contrast by making the highlights lighter and 
the shadows darker. It can also be used to decreases the contrast.

Move the Contrast slider to the right to increase contrast (S shaped 
curve), or to the left to decrease contrast (inverted S shaped curve).

Before/After view

Toggle between the Before and After views

Before/After view

View the Before and After views in portrait

Before/After view

View the Before and After views in landscape

This button: Enables you to:
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Contrast Center

Contrast increases the image contrast mainly in the midtones. Using 
Contrast Center, you can adjust where the contrast is increased. To 
enhance contrast in highlights, the Contrast Center is shifted toward the 
highlights. To enhance contrast in shadows, the Contrast Center is shifted 
toward the shadows.

Set the image contrast, by adjusting the Contrast slider.

Your change affects the gradation graph by moving the point where the 
curve changes from convex to concave.

Organizing Gradation Tables
The Gradation window provides a number of options for organizing 
gradation tables, including Reset, Save, Delete and Save As.

If you work only with the default gradation table, the Reset and Save As 
options are activated. This option enables you to use the default gradation 
table as a base on which to build and save new gradation tables. When you 
work on gradation tables other than the default table, Save and Delete are 
also active.

To reset all Gradation window settings, click Reset. 

The gradation curve is reset to a 45° line. 

To delete the selected gradation table, click Delete. 

To save the specified gradation settings, click Save.

To create new gradation tables by saving existing gradation tables with 
new names, click Save As.

Note:  Contrast Center only affects the image if Contrast has also been 
adjusted.

Note:  You can not delete the DefaultGradTable.

Note:  You can only save the default gradation table under a new name.
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Setting Up and Configuring the Spire CX250 Color 
Server

Basic system configuration and settings are defined in the Spire CX250 
color server Settings window.

To open the Settings window, from the Tools menu select Settings.

The settings are divided into two lists; Administration and Preferences. 
Both lists are explained in the following sections.

All items in the Settings window are view-only to Guest users. Items in the 
Administration list can only be changed by users of Administrator level. 
Items in the Preferences list can only be changed by users of Administrator 
and Operator levels. 

Server Setup
Set the server’s name and the current date and time in Server Setup.
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Changing the Server Name
1. In the Settings window, select Server Setup.

2. In the Server Name area, click Change.

The System Properties dialog box appears.

3. In the Computer Name tab, click Change.

The Computer Name Changes dialog box appears.

Note:  The System Properties dialog box appears differently, according to server 
type.
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4. In the Computer Name box, type a new name for the computer. 

5. If you want to change the Workgroup or the Domain in which your 
computer appears, select the desired option and type a new name in 
the corresponding box.

6. Click OK.

7. Click OK in the System Properties window.

The system prompts you to reboot your computer for the new settings 
to take effect. 

8. Click No if you want to change other system parameters, or click Yes 
and reboot your computer.

Changing the Date and Time
1. In the Settings window, select Server Setup.

2. In the Date & Time area, click Change.

The Date/Time Properties dialog box appears.

Note:  Do not change the workgroup or domain unless you are instructed to 
do so.

Important:  If you want to change the domain, you will be required to type 
the password for the domain account. If the password is unavailable, the 
computer will be locked.
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3. In the Date & Time tab, select your local time settings.

4. Select the Time Zone tab and set the correct time zone.

5. Click OK.
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Network Setup
The IPX Printing settings, TCP/IP settings and the Apple Talk settings are 
set in the Network Setup parameter.

IPX Printing
IPX Printing enables the Spire CX250 color server to act as a job server for 
the Novell queue. A job server checks each assigned queue at a specified 
interval, taking care of jobs on a first-in, first-out basis. Once a job is 
processed, its associated file is deleted from the queue directory.

1. In the Settings window, select Network Setup.

2. In the IPX Printing area, click Change Settings next to the Tree 
parameter.

The Local Area Connection Properties dialog box appears, followed by 
the NWLink IPX/SPX Properties dialog box.

Note:  IPX Printing works in a Novell environment.
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3. To change the frame type, select a frame type from the Frame type list, 
then click OK.

4. Click OK also in the Local Area Connection Properties window.

You are prompted to restart your computer. 

5. Click No if you need to make more changes, or Yes to reboot.

TCP/IP Setup
The Spire CX250 color server is predefined with a default IP address. The 
TCP/IP option enables you to change this IP address and other TCP/IP 
settings.

Note:  Using this procedure requires further setup by the network 
administrator.

Note:  Before changing the network settings, consult your System Administrator.
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To change the TCP/IP network settings:

1. In the Settings window, select Network Setup.

2. In the TCP/IP area, click Change Settings next to the IP Address 
parameter.

The Local Area Connection Properties dialog box appears, followed by 
the Internet Protocol (TCP/IP) Properties dialog box.

3. Change the IP Address by selecting Obtain an IP address 
automatically.
Or:
Select Use the following IP address and type the desired address—for 
example, IP address:192.168.62.1 and Subnet mask:255.255.255.0.

4. Click OK.

5. Click OK in the Local Area Connection Properties window.

You are prompted to restart your computer. 

6. Click No if you need to make more changes, or Yes to reboot.
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Apple Talk Setup
The AppleTalk Setup utility enables you to change the AppleTalk zone in 
which your Spire CX250 color server is located.

To change the Apple Talk network settings:

1. In the Settings window, select Network Setup.

2. In the Apple Talk Setup area, click Change Settings next to the The 
System will appear in zone parameter.

The Local Area Connection Properties dialog box appears, followed by 
the AppleTalk Protocol Properties dialog box.

3. From the zone list, select the desired AppleTalk zone for your 
computer, and click OK.
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Remote Tools Setup

 

The Web connect Setup enables clients to connect to the Spire CX250 
color server over the network by using the Spire Web Center. This option 
is disabled by default.

1. In the Settings window, select Remote Tools Setup.

2. Select Enable WebViewer to connect to the Spire CX250 color server 
using the Spire Web Center.

For more information about viewing and monitoring your jobs from a client 
workstation, see Web Center on page 23.
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Security

User Passwords
For security, you can set passwords for users for when they log in to the 
Spire CX250 color server.

To set Password settings:

1. In the Settings window, select Security.

2. Select Auto Log On to enable users to log on automatically.

3. Select Disable Guest Connection to prevent Guest users from 
accessing the Spire CX250 color server.

Note:  These passwords do not apply to the Remote Desktop Application. For 
more information on the Remote Desktop Application, see Working from the 
Remote Desktop Application on page 16.

Note:  When you enable Auto Log On, all other options in the Passwords area 
are unavailable.
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To change Administrator/Operator passwords:

1. In the Settings window, select Security.

2. In the Administrator/Operator area, enter the old password.

3. Enter the new password.

4. Verify the new password.

5. Click Apply and Save in the Settings window.

The password is changed and the Settings window closes.

Disk Wipe
Usually when you delete a file, the file’s dictionary entry is removed but 
data still remains on the disk. The Disk Wipe utility enables you to clear 
previously deleted files. The utility eliminates the contents of your deleted 
files by scanning all of the empty sectors on the disk and replacing them 
with zeros. Nonempty sectors are left untouched. This feature enables you 
to work in a more secure environment. If there is a system shutdown, the 
disk wipe operation can begin immediately.

To operate the Spire Disk Wipe utility:

1. In the Settings window, select Security.

2. To enable the disk wipe feature, select Wipe disk on system 
shutdown.

3. Click Save.

4. Exit the Spire CX250 color server application.

Notes:

• The disk wipe operation does not function well when the Norton Utilities 
application is installed. Before you activate the Disk Wipe utility, make sure 
that Norton Utilities is not installed on the Spire CX250 color server.

• In rare cases, the process of deleting files from the Storage window is not 
completed—for example, the system shuts down before the deletion process 
is completed. When this happens, parts of the deleted files still reside in the 
D\:Output folder. Therefore, it is recommended that before you start the 
disk wipe operation, check the D\:Output folder to ensure that all the 
relevant files were deleted.

• The Disk Wipe utility affects the user disk and printer disk.

• Do not operate the Disk Wipe utility while another application is running.

• The supported language is English.
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System Disks
When the Printer or User Disks reach a pre-defined threshold of 
minimum available space (the default is 250 MB), RIP is suspended and 
the system provides a warning message. The RIP will resume automatically 
only after disk space is available. 

1. In the Settings window, select System Disks.

2. To set the system disks threshold, in the System Disks area, set the 
minimum free disk space desired for RIP.

Backing up the Configuration
You can back up the Spire CX250 color server configuration to a local hard 
disk, network drive, or external media—for example, an external zip 
drive—connected to the Spire CX250 color server.
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Configuration Backup

To backup the configuration of your Spire CX250 color server:

1. In the Settings window, select Configuration Backup.

2. In the Configuration Backup area, click Browse.

The Save window appears.
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3. Browse to the desired directory path for the backup.

4. Enter the desired file name.

5. Click Save.

6. In the Settings window, click Start Backup.

Configuration Restore

To restore the configuration of your Spire CX250 color server:

1. In the Settings window, select Configuration Backup.

2. In the Restore Configuration area, click Browse and locate a different 
directory path in which to restore the configuration. 

3. Click Start Restore.

Note:  You can also backup to an external media.

Note:  You can also restore the configuration from an external media.
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The Restore Configuration window appears.

4. Select the categories you want to restore, and click OK.

The following message appears:

5. Click Yes if you would like the restored files to replace the current 
ones. Click No if you do not want the restored files to replace the 
existing files.

Note:  When restoring the configuration all the custom tables or sets are 
added to the system for example—imported user-defined imposition 
templates, new virtual printers, downloaded fonts and so on.

Note:  The Restore Configuration date is updated in the Configuration 
Backup window.
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Calibration Device

1. In the Settings window, select Calibration Device.

2. In the Calibration Device area, select the Use external calibration 
device check box if you want to calibrate using the X-Rite DTP34 
QuickCal densitometer.

Note:  This parameter is available only if you have the Pro configuration.
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Localization
Set the locally-used unit measurements and language in the Localization 
parameter.

Setting the Localization Measurement
1. In the Settings window, select Localization.

2. In the Units area, select Millimeters or Inches, as desired.

Setting the Language
1. In the Settings window, select Localization.

2. In the Language area, select the language, as desired.

Note:  If you switch to another language, you need to restart the Spire CX250 
color server application.
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Pre-RIP Preview

1. In the Settings window, select Pre-RIP Preview.

2. In the PS preview area, select one of the following options: 

• Save file as PDF: closes the Adobe Acrobat preview and saves the 
file as a PDF

• Return to the original PS file: closes the Adobe Acrobat preview 
but does not save the file

3. In the VI Job Preview area, select the desired number of booklets for 
pre-RIP preview.
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General Defaults

1. In the Settings window, select General Defaults.

2. In the Default Image Size area, select the Size.

3. Select the desired OPI setting to specify how an external high-
resolution image is placed in a PostScript file as it goes to RIP.

If you select Enable OPI Spire Support, the Support Helios Server 
check box is automatically selected. If you do not want Helios server 
support, clear this check box.

4. Select the Default archive path.

5. In the Test Page area, select Enable to set a test page to be printed 
every time the Spire CX250 color server is restarted or powered on.

For more information on the default archive path, see Archiving and 
Retrieving Jobs on page 46.



Setting Up and Configuring the Spire CX250 Color Server 159

6. In the Job Title Recognition area, select one of the following options:

• Use PostScript Internal name: select this option to use the internal 
file name as written inside the PostScript file by the print driver.

• Use files name (Use when Printing via LPR): select this option to 
use the job’s given file name. Selecting this option ensures that the 
job appears in the Spire CX250 color server with the name last 
given by the user.

Printing Modes
You can set the Spire CX250 color server to automatically select the best 
finishing option for your job when the finishing option you want is 
unavailable.

1. In the Settings window, select Printing Modes.

2. In the Printing Policy area, select Print job to best finishing option 
available.
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Print Queue Manager

Job batching
The job batching utility enables you to print several jobs with the same 
settings in a batch without cycle down between jobs, which saves 
production time.

1. In the Settings window, select Print Queue Manager.

2. Select one of the following options:

• Enable Job Batching to print jobs with the same page parameters, 
one after the other without the cycle down.

• Disable Job Batching to disable the printing of jobs with the same 
page orientation, one after the other, and enable cycle down.

For more information about job batching, see Batching Jobs on page 37.
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Held jobs
1. In the Settings window, select Print Queue Manager.

2. In the Held Jobs Policy area, select one of the following options:

• Bypass held jobs to bypass frozen jobs in the In Print queue.

• Don’t Bypass held jobs to stop the printing from the queue when a 
job is assigned a frozen status.

Color
Note:  This parameter is available only if you have the Pro configuration.
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Automatic Screening
The Spire CX250 color server supports Dot and Stochastic screening. 
When you print a job from the Spire CX250 color server, select the 
automatic screening method. By default, automatic screening applies two 
types of screen:

• For text or line-art elements (line work), the system uses line type 
screen of Line 200.

• For continuous tone (CT), the system uses dot type screen of Dot 200.

To change the values of the automatic screening method:

1. In the Settings window, select Color.

2. Select the required setting for LW from the LW list.

3. Select the required setting for CT from the CT list.

You are prompted to restart the application for the new settings to take 
effect.

Calibration Reminder
Set the Calibration Reminder to remind you when to perform a 
calibration.

1. In the Settings window, select Color.

2. In the Calibration Reminder area, select the Set calibration reminder 
every (Hours) check box and select the number of hours in the list.

The calibration reminder indicator appears when it is time to 
calibrate.
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Messages

Alert Messages
The Alert Messages utility enables you to select whether the Alerts window 
will open automatically when an error occurs.

To set the Alerts window settings:

1. In the Settings window, select Messages.

2. In the Alert Messages area, select one of the following:

• Launch Alerts window automatically on new error (default)

• Launch Alerts window on user selection only

Accounting Log Setup
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CX250 color server Accounting window. This utility enables 
you to specify different values for how long information remains before 
being overwritten.
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To setup the accounting log:

1. In the Settings window, select Messages.

2. In the Accounting log setup area, select the desired value to 
Overwrite messages after. 

3. To remove all the existing information from the windows, whenever 
desired, click Clear Log Now.

Message Viewer Log Setup
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CX250 color server Message Viewer. This utility enables you to 
specify different values for how long information remains before being 
overwritten.

To setup the message viewer log:

1. In the Settings window, select Messages.

2. In the Message viewer log setup area, select the desired value to 
Overwrite messages after. 

3. To remove all the existing information from the windows, click Clear 
Log Now.

Note:  For more information about the Accounting window, see Job 
Accounting on page 97.

Note:  For more information about the Message Viewer, see The Message 
Viewer on page 171.
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View Configuration
The View Configuration utility enables you to view the configuration of 
your Spire CX250 color server and to print it to any printer on the network 
connected to your Spire CX250 color server. In addition you can save the 
configuration in the network or export it to an external media as a text file.

To view the configuration:

1. In the Settings window, select View Configuration.

2. Click Print to print the configuration.

The Print window appears.

3. From the Printer list, select one of the defined printers and click OK.

4. If you would like to save the configuration click Export.

The Save window appears.
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5. Locate the desired folder, and click Save.

JDF Outputs
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The Spire CX250 color server receives the JDF job ticket via hot folders, 
returns JDF output with job accounting information, and submits JMF 
(Job Messaging Format) signals with the job's status. 

If the JDF job has a target path specified in the job, JDF output is always 
created. For JDF jobs that don’t have a specified target path, the JDF 
output is only created if this option is selected in the Settings window. 

1. In the Settings window, select JDF Outputs.

2. Select Create JDF Outputs to create JDF output.

3. In the Target Path box, enter the target path, or click Browse to 
browse to the desired directory path for the JDF output.

Scan

Automatic Job Deletion
1. In the Settings window, select Scan.

2. In the Automatic job deletion area, select the number of days in the 
Delete scan jobs after list.
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To delete scanned jobs:

In the Automatic job deletion area, click Delete Now.

Remote Access
Using the remote scan application, you can enable remote scanning for all 
users or Administrators only.

To enable remote access:

1. In the Settings window, select Scan.

2. In the Remote Access area, select the Enable Remote Scan Application 
connections check box.

3. Select your choice for ScanBox Manager access control:

• All users

• Administrator only

Storage Management
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Automatic Job Deletion
Set the time interval (in days) for automatically deleting stored jobs.

To set automatic job deletion:

1. In the Settings window, select Storage Management.

2. In the Automatic job deletion area, select the number of days after 
which stored jobs are automatically deleted.

Frozen Jobs
Set the time interval (in hours) for automatically deleting frozen jobs.

1. In the Settings window, select Storage Management.

2. In the Frozen Jobs area, select the number of hours after which frozen 
jobs are automatically deleted.

System Messages
While jobs are being handled by the Spire CX250 color server, various 
messages are emitted. You can view the messages of each job in the Job 
History window, of the entire session in the Message Viewer window, or 
just the error messages within the Alerts window.

The Alerts Window
By default, the Alerts window is open in the Spire CX250 color server 
workspace. Any time the system emits an error message, the message 
appears in the Alerts window. The Alerts window lists all the error 
messages that were generated during the workflow (the total number of 
messages is also indicated). 

From the View menu, select Alerts.

The Alerts window appears, listing all the error messages that were 
generated during the workflow. 

Note:  You can specify whether you would like the Alert window to launch 
automatically on a new error, or upon user selection only. To set the preferred 
option, see Alert Messages on page 163.
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To delete messages from the Alerts window:

Do one of the following actions:

Select the message(s) you want to delete and click Clear. 

To remove all messages, click Clear All.

System Disks Threshold Message
When the Printer or User Disks reach a pre-defined minimum available 
space threshold (usually of 250 MB), RIP is suspended and the system 
provides a warning message. The RIP resumes automatically only after 
disk space is available. In this case, you may increase the System Disk 
threshold.

Note:  By default, new messages are shown at the top of the list. For each 
message, the origin of the message is indicated, and a task that will solve the 
problem is suggested.

Note:  Cleared messages are not removed from the Message Viewer or from 
related Job History windows.

For more information about setting the system disks threshold, see System Disks 
on page 151.
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Job History

To view the job history:

Right-click a job in the Queues or Storage window, and from the menu 
select Job History.

The Job History window appears, listing all the messages that were 
generated during the workflow of the selected job.

The Message Viewer

To open the Message Viewer:

At any stage of work, from the Tools menu, select Message Viewer.

The Message Viewer window appears, listing all the messages that were 
generated during the workflow. 

For information on the messages display, see Managing Messages on page 172.

For more information about viewing messages related to a specific job, see 
Job History on page 171.
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By default, all the jobs that were handled during the last 3 months (90 
days) are listed. 

Managing Messages
You can filter the messages by type, or sort the list by one of the column 
headers. In addition, you can print the list of messages.

If desired, you may reorder and resize columns, filter the list or sort the list 
by one of its column headers.

The default may be changed in the Settings window under Messages. For 
more information about changing the default setting, see Messages on 
page 163.

Notes:

• This section is relevant for the Message Viewer and Job History windows (but 
not for the Alerts window).

• These settings are retained after closing a window.
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Filtering the Messages by Type

Each message in the Message Viewer and Job History window is assigned 
an icon to denote the message type:

By default, all message types are listed in the Message Viewer. You can filter 
the list in order to view only messages of certain types. 

Click any message type icon—for example, Error— in order not to list 
such messages.

The list updates accordingly.

To print the message list:

1. Filter and sort the list as desired (the data is printed according to the 
current filtering and sorting).

2. Click Print List.

The Print window is displayed.

3. Set the printing options as desired, and then click OK.

Information

Warning

Error

Note:  If the message type is not selected, messages of this type do not 
appear in the list.
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Setting Parameters in the Job Parameters 
Window

This section describes the Job Parameters window, and explains how to set 
the job parameters.

The Print Settings Tab

Number of Copies
Type the number of copies to be printed.

For more information about opening the Job Parameters window, see The Job 
Parameters Window on page 51.
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Print Range 
Select the desired print range.

To select specific pages, booklets or page ranges, select Pages/Booklets 
and specify the pages or booklets to be printed as follows:

Type one or several numbers separated by commas and no spaces. 
For example—1,3,5.

Type a range of pages or booklets with a hyphen between the 
starting and ending numbers in the range. For example—1-5.

Print Method
Select one of the following options:

Simplex: for single-sided printing

Duplex Head to Toe: for calendar-style hard copies (usually used 
with landscape jobs)

Duplex Head to Head: for book-style hard copies (usually used with 
portrait jobs)

Print Order
Set the print order to From 1 to N (front to back) or From N to 1 (back 
to front).

Delivery
Select Face up or Face down as the delivery option.

Collation
Select the Collation option:

Yes: prints a complete copy of the job before the first page of the 
next copy prints

No: prints all copies of each page before going on to the next page

Note:  For imposed jobs, instead of typing the desired pages, you should type 
the desired imposed sheets.

Note:  To collate a document and print the set in the correct order, select Face 
Down and From N to 1, or Face up and From 1 to N.
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Image Position
This parameter enables you to change the location of the entire printed 
image on the sheet (simplex or duplex).

Image position uses the following terminology: 

• Rear: the edge of a sheet at which printing stops, near the rear of the 
printer

• Lead: the edge of a sheet at which printing begins

The page’s lead and rear edges are determined just after the page is printed 
out, before making any change in page orientation.

Select one of the following:

To print your job in the center of the page, click Center

To set page offsets, click the directional arrows or type Rear and 
Lead values

To apply page offset values to both odd and even pages, select the 
Same on both sides check box.

Image Scale
Perform one of the following:

To print the image original size, select 100% (default)

To fit the image to the selected paper size, select Fit to Paper

To custom size the image, select Custom and type the percent by 
which you would like to proportionally increase or decrease the 
image size

Rotate 180
To rotate your job by 180°, select Yes.

Tip:  Use this option to move duplex page data away from the spine.



Setting Parameters in the Job Parameters Window 179

Gallop

Gallop enables the job to start printing before the entire job is RIPed. 

Select Yes and type the number of pages to RIP before printing starts.

The Paper Stock Tab

 

Paper Size
From the Size list, select the desired stock size. If you select Custom:

a. Type the desired height and width. 

b. Select the desired feed direction:

• LEF (Long Edge Feed)

• SEF (Short Edge Feed)

Note:  This option is available only if you have the Pro configuration.
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Tray
In the Tray list, select the desired tray, and load the specific stock in this 
tray. If you select Auto, any tray with the specific paper stock is used. 

Media Type
1. In the Media Type list, select the desired media.

2. In the Image Quality list, select the attributes of the media. The 
options vary according to the media that you selected in the Media 
Type list.

3. To create a glossy finish on the job pages, select Gloss Enhanced.

4. To print the second side of each page in a manual duplex workflow, 
select Side-2 printing.

Note:  Make sure that the paper in the selected tray complies with all the other 
paper stock parameters. If the paper in the tray does not match all the paper 
stock parameters, the job is frozen.

Tip:  If you selected Transparency, select the Add interleave check box to 
insert a blank page between each transparency. To customize the interleave, 
select a different paper size, media type, or tray from the appropriate lists.

Note:  Side-2 printing is not supported for all media types.
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The Print Quality Tab

Text /Line Quality
The Text/Line quality parameter improves text quality. Text/line quality 
and text and line-art elements are processed separately to produce optimal 
rendering of all the elements on a page. This option improves the text 
quality of diagonal lines, borders, and blends; causes blends to appear 
smooth with no banding; and displays crisp diagonal lines without (or 
with minimal) jaggies (rough edges) which are the result of the limited 
resolution of the print engine.

1. Select High to improve the text quality.

2. In the Enhance area, select the Overlapping elements check box to 
enhance to improve the quality of overlapping vector and image 
elements.
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Image Quality
The Image quality parameter controls the ability to maintain the same 
detail and smoothness at different degrees of enlargement. This feature is 
especially useful when your PostScript file includes several images of 
different qualities—for example, images that were scanned at different 
resolutions, were rotated, or were downloaded from the Internet.

1. Select High to improve the quality of images in a job.

2. In the Enhance area, select the Graphics check box to improve the 
quality of overlapping vector and image elements.

Trapping
Trapping is a solution that solves misregistration between color 
separations in both offset and digital printing. Misregistration occurs 
regardless of the accuracy of the printing device and results in white lines 
around objects on top of a background (in a knock-out procedure) and 
also between adjacent colors. Trapping extracts the element or the 
background in order to create an overlap between them. 

1. To set trapping, select Yes.

2. In the Frame Thickness box, select the default (0.08mm) for the 
thickness of the trapping frame, or type the desired value. The thicker 
the frame, the less chance that white areas appear will between images.

Note:  When you select High, the processing speed is decreased.

Notes:

• If you select Yes, the Frame Thickness and Protect Small Text options 
are activated. You cannot select these options in the PPD file.

• If you select No, trapping incorporated by DTP applications (for example, 
Photoshop®) are not affected. Creo Full Auto Frame trapping software 
(FAF) should not be used with application-based trapping. In a PostScript 
file that already contains trapping from the originating application, it is 
not necessary to use Spire CX250 color server trapping.
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3. Do one of the following actions:

• Select the Protect Small Text check box to prevent the trapping of 
any text that is 12 points or smaller.

• Clear the Protect Small Text check box to trap all text elements.

Black Overprint
Select Yes to ensure that black text prints cleanly within a tint or 
picture area.

The text appears in a richer, deeper black, with the underlying CMY values 
equal to those of the printed background. 

PS Overprint
Select Yes to use the overprint information in the Postscript file.

This parameter also determines whether the DTP application overprint 
settings are honored in the RIP. 

The Color Tab
The Color tab provides you with tone compression tools such as 
brightness, contrast, and gradation, as well as color tools, including 
rendering intent, ink saving, and RGB and CMYK workflows. In addition, 
you can select various screening methods for your job.

Tip:  Apply the Protect Small Text option to small or complex images to ensure 
their quality is not decreased.
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The Spire CX250 color server accepts the following color formats:

• RGB

• CMYK

• L* a* b*

• Spot color

• Greyscale

• Duotone

Note:  If you change any of the Destination, Rendering Intent, Emulation, 
RGB Workflow, or Spot Color Editor settings in your RTP job, the Spire CX250 
color server re-RIPs your job. If you do not wish your job to be re-RIPed, apply the 
options prior to initial RIPing.

The Gradation, Brightness, Contrast, and Calibration settings do not require 
re-RIP.
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Color Mode
Select one of the following options:

Color: to print the job in color using CMYK.

Grayscale: to print the job as black and white using Black (K) toner 
only. When a color job is printed using the Grayscale option, the 
cyan (C), magenta (M), and yellow (Y) separations are also printed 
in black (K) toner, giving a dense appearance similar to the CMYK 
grayscale image.

RGB Workflow
1. In the RGB Workflow list, select the required RGB source profile: 

• To use the embedded color space array (CSA) or source CSA, 
select Use SourceCSA.

• To use a Spire or Adobe CSA, select a CSA from the list. The 
default option is AdobeRGB1998.

2. In the Rendering intent list, select the required option.

3. To print RGB gray text and graphics with black toner only, select the 
Print grays using black toner check box.

CMYK Workflow
The CMYK workflow option is used to emulate various standards used in 
lithographic printing. These standards represent specific combinations of 
paper and ink, as well as popular proofing systems. The CMYK workflow 
is also used to emulate other digital printers or other printing devices such 
as offset presses. An example of a CMYK workflow job would be printing 
a test sample for a survey before moving to an offset press to print millions 

Note:  If the job contains grayscale images that were created in RGB 
applications, such as Microsoft® PowerPoint®, specify as monochrome or 
submit to the system with Grayscale selected in the PPD file. This selection 
ensures that grayscale images are counted as black and white instead of 
color in both the Spire CX250 color server and the Xerox DocuColor 240/250 
printer-copier billing meters.

Note:  The Print grays using black toner check box not only affects 
R=G=B values but might also cause slightly different values 
(R+/-4=G+/-4=B+/-4) to produce gray.
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of survey forms. In such a case, it is best to emulate the offset before the job 
actually goes to offset printing. The Spire CX250 color server supports the 
device link CMYK emulation methods.

Use the CMYK workflow parameter to specify the required rendering 
intent for CMYK elements. All printers, monitors, and scanners have a 
range of colors (gamut) that they can output (or view, in the case of a 
scanner). If a color needs to be output and is outside the gamut of the 
output device, it must be mapped to another color that exists within the 
gamut.

Use rendering intent to compress out-of-gamut colors into the color 
capability of the press you are using. You can select any rendering intent 
value for CMYK elements from the Rendering intent list. The default value 
for CMYK is Relative Colorimetric.

In addition, you can emulate the paper tint and adjust the white point 
value of the used paper stock. For example, if you want to simulate pink 
paper while using white paper, use the corresponding emulation profile 
and select Emulate source paper tint.

To select CMYK workflow options:

1. In the Original list, select one of the following options:

• Direct: to print the CMYK elements without any color 
transformation.

• Use Source CSA: to use the embedded CSA from the PostScript 
file.

2. In the Emulation list, select the required emulation. 

Note:  RGB colors are not affected by the CMYK workflow.

Note:  The system emulates the selected option during the RIP process. GCR 
(Gray Component Replacement) and CMYK Emulation do not affect the 
processed job.
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• To emulate the original paper tint, select the Emulate source paper 
tint check box. 

• Select Emulate RGB elements to convert RGB elements according 
to the selected CMYK emulation method. The RGB elements 
receive the same look as the CMYK elements, creating a consistent 
appearance.

• Select the Preserve pure colors check box to preserve pure cyan, 
magenta, yellow, and black during transformation.

3. In the Rendering intent list, select the required option. 

Spot Workflow
By default, the Spire CX250 color server looks in the spot color dictionary 
for the correct value each time there is a spot color with a recognized name. 

To ignore the spot color dictionary:

In the Spot workflow options area, clear the Use Spire spot color 
dictionary check box.

Notes:

• The Emulate source paper tint check box is available only if you 
select Device Link as the emulation method.

• When you select the Emulate source paper tint check box, the 
Spire CX250 color server applies the absolute colorimetric rendering 
method.

• If the job is simplex, only the front side is printed using the tint 
emulation.

• Paper tint emulations are available only if you have the Pro 
configuration.

Notes:

• If you selected Device Link as the emulation method, Rendering 
intent is unavailable because a rendering intent is already defined for 
each device link emulation.

• Custom CMYK Device Link emulations are available only if you have the 
Pro configuration.

For more information about the Spire spot color dictionary, see Spot Color 
Editor and Workflow on page 128.
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Destination Profile
Select the required profile. There is one predefined Spire CX250 color 
server profile, SpireDC250.

Screening
Screening converts Continuous-Tone (CT) and Line-Work (LW) images 
into information (halftone dots) that can be printed. The human eye 
“smooths out” this information, which seems visually consistent with the 
original picture. Thus, the more dots per inch, the more natural the image 
appears. 

The Spire CX250 color server supports line screening. Screening is 
achieved by printing lines in an evenly-spaced pattern. The distance 
between screen lines is fixed, and the line thickness varies, depending on 
the intensity of color required for the job. 

Using screening, printers can work with even amounts of toner and still 
produce a wide range of colors. The darker the color, the thicker the line. 
In this manner, screens give the appearance of different toner quantities 
printed in a certain area.

The Spire CX250 color server currently supports a line screen of 200 lpi 
(200C is the default setting). The screen of each separation is printed at a 
different angle.

Calibration
The purpose of color calibration is to achieve a consistent level of color 
quality. Calibration corrects printer colors by measuring a color density 
chart. 

The Spire CX250 color server calibration tool enables you to create 
calibration tables, either through an automatic process or by editing an 
existing calibration table. The available calibration options are Normal, 
Saturated, and None.

The Calibration parameter enables you to select the required calibration 
table for the job.

For more information about calibration tables, see Calibration Overview on 
page 108.
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To select a calibration table for a job:

In the Calibration list, select a calibration table. The default calibration 
table is Normal.

Ink Saving (GCR)
Gray component replacement (GCR) prevents the consequences of 
excessive toner buildup, such as flaking and cracking, and the "curling" 
effect that may occur when you print transparencies.

To set ink saving, select one of the following options:

None: no GCR is performed on the file, and the printer applies 
maximum dry ink coverage.

Low, Medium, or High: the selected amount of CMY dry inks 
replaces the black dry ink.

Color Adjustments

Gradation

The Gradation list contains gradation tables that were created by the Spire 
CX250 color server’s Gradation tool. Each gradation table contains specific 
settings for brightness, contrast, and color balance.

When you select a predefined gradation table, your job is adjusted 
according to the specific table’s settings. 

Tip:  For optimal printing performance, use the Normal calibration setting 
with Ink Saving (GCR) set to Medium.

Note:  There is no change in the color quality of the printed image even though 
the gray component of each color is replaced by black

Tip:  Select High for minimum ink coverage and thus save on toner. High also 
prevents curling effects.

For more information about creating gradation tables, see Gradation Tool on 
page 131.
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In the Gradation list, select one of the defined gradation tables. 

Brightness

Use this option to make last-minute adjustments to the print job after 
proofing.

To select a brightness level for a job, move the Brightness slider to the 
required brightness level (the range starts from Light, which applies 
-15%, to Dark, which applies +15%). 

Contrast

Adjust the Contrast option to control the difference between light and 
dark tones in your image.

To select a contrast level for the print job, move the Contrast slider to 
the required contrast level (the range starts from Less, which applies 
-10%, to More, which applies +10%).

Note:  The default setting is None. No gradation table is applied to your job.
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The Imposition Tab
The Imposition tab enables you to set job options related to the 
positioning, folding, trimming, and binding of pages.

Imposition Method
The Imposition Method parameter specifies how printed sheets are 
finished. 

Select one of the following options:

None: no imposition (this is the default option). The imposition 
parameters are unavailable and the thumbnail viewer does not 
display an image.
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Step & Repeat: prints multiple copies of the same image on one 
sheet so that the sheet is used to maximum capacity. This method is 
used mainly for printing business cards.

If you select Step & Repeat, the following option is available:

• Cut & Stack: enables Step & Repeat jobs to be printed, cut, 
stacked, and bound in the most efficient manner while 
preserving the original sorting. A job’s pages, booklets, or 
books are sorted in a Z-shape. In other words, each stack of 
pages is sorted in consecutive order. When stacks are piled one 
on top of another, the entire job is already sorted up or down.

Saddle Stitch: prints pages ready for applying a book-finishing 
technique in which the pages of a book are attached through 
stitching or stapling in the spine fold—for example, brochures.

Perfect Bound: prints pages ready for applying a book-finishing 
technique in which the pages of a book are attached by trimming 
the spine fold, roughening the edges of the gathered pages, and 
gluing them together—for example, hardcover books.

Sizes
1. In the Paper size list, select the desired paper stock size. If you select 

Custom, type the height in the H box and width in the W box, and then 
select LEF or SEF.

2. In the Media type list, select the desired paper stock type. The default 
setting is Use Printer Settings. When this option is selected, your job 
is printed on the media type that is defined on the Xerox DocuColor 
240/250 printer-copier.

Notes:

• When you use the Step & Repeat template for VI jobs, the system 
prints the job in Z-Sorting mode. This enables imposed VI jobs to be 
sorted for cut-and-stack finishing.

• It is possible to use specific step-and-repeat templates to print several 
different images on one sheet.

• This option is available only if you have the Pro configuration.

Note: If you select Cut & Stack, you cannot make changes or enter a 
valid exception on the Exceptions tab.
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3. In the Tray list, select the required tray. If you select Auto, any tray 
with the specific paper size will be used.

4. In the Trim Size list, select the desired trim size. Trim size is the size of 
the finished, trimmed document. You can adjust your page size by 
adjusting the trim size.

• If you select Custom, define a custom trim size and type the 
desired height in the H box, and the desired width in the W box. 

• Select Portrait or Landscape. If the wrong orientation is specified 
an unsuitable template might be selected and the job might be 
cropped as a result.

Template
1. If you have the Pro configuration, in the Category area, select one of 

the following options:

• System: to choose a predefined Spire CX250 color server 
imposition template.

• User-defined: to choose a user defined Spire CX250 color server 
imposition template.

2. In the Template list, select an available template.

3. In the Columns list, select the number of pages to place horizontally. 
The rows and columns indicate how the pages will be placed on the 
sheet.

Note:  If you set the trim size to be smaller than the page size set in the DTP 
application, some of the data is cropped. Setting a larger trim size results in a 
larger border on the printed page.
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4. In the Rows list, select the number of pages to place vertically.

5. Select the desired layout—for example, Duplex HTH or Duplex HTT.

6. Select the North South check box if the template you chose is either 
step and repeat 2×1 or 1×2. The pages will be placed 180 degrees from 
each other, on the same side of the imposed sheet.

User-Defined Imposition Templates

The Imposition Template area enables you to import and manage user-
defined imposition templates that were created in a stand-alone 
application—for example, Ultimate inSpire. 

To import a user-defined imposition template:

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Imposition Templates.

3. Click the Import button .

Note:  User-defined imposition templates are available only if you have the Pro 
configuration.

Note:  This option is available only if you have the Pro configuration.
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4. In the Open dialog box, locate the user-defined template that you 
want to import. 

5. If you want to lock the template, select the lock job ticket check box.  

6. Click Import.

To rename a user-defined imposition template:

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Imposition Templates.

3.  Select a user-defined imposition template from the list, and click 

Rename .

Note:  If the template is locked, you cannot set imposition parameters in the 
Job Parameters window.
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4. Type a new name for the user-defined imposition template.

5. Click OK.

The renamed user-defined imposition template appears in the 
imposition template list.

To delete a user-defined imposition template:

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Imposition Templates.

3.  Select a user-defined imposition template from the list, and click 

Remove .

Margins
Enter the desired margins sizes to adjust the spaces between the 
outside edges of pages and the edges of the sheet on which they are 
printed. 

Margin settings need to suit finishing equipment and requirements. 
Confirm binding parameters with your binder when planning your sheet.

Marks and Bleed
The Marks & bleed parameter enables you to mark where trimming and 
folding should occur. 

When you set bleed options, you extend part or all of the printed image 
beyond the trimming boundary. The bleed options ensure that an 
inaccurate trim setting will not leave an undesired white space at the edge 
of the page. The bleed options produce sharp page boundaries with color 
that extends all the way to the edge of the page.

To select marks and bleed options:
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1. In the Marks area, select one of the following options:

a. To print the lines that indicate where the sheet should be cropped, 
select the Crop Marks check box.

• To print the crop marks on both sides of the page, select the 
Both sides of sheet check box.

b. To print the lines that indicate where the sheet should be folded, 
select the Fold Marks check box.

2. In the Bleed area, select one of the following options:

• Maximum bleed: Use this option to extend the bleed to the sheet 
fold lines.

• Custom bleed size: Type the desired bleed size in millimeters.

Note:  

• Crop marks are placed according to the Trim Size option. A minimum 
of 6 mm is required for crop marks and 10 mm for fold marks.

• If your job already includes crop marks incorporated by the DTP 
application, you do not need to add crop marks here. If you do add crop 
marks, both sets of crop marks can be printed.

• If you want to use crop marks incorporated by the DTP application, 
make sure that enough space is left around your page in the PostScript 
file so that the page prints with crop marks.

Note:  

• You cannot extend the bleed size beyond the sheet fold lines. Bleed 
does not affect the position of crop marks.

• Bleeding must be defined in your DTP application in order for the Spire 
CX250 color server to be able to apply the bleed options.
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The Services Tab

Job Deletion
Select this parameter to delete each page on the fly once it has been 
successfully printed. In this way, the Spire CX250 color server maintains 
enough free disk space for the duration of the print run. Reusable elements 
are not deleted.

To set a deletion policy:

1. Suspend the Process Queue, and import your job.

2. On the Services tab, in the Automatic deletion options area, select 
one of the following options:

• To delete pages or jobs after printing is completed, select Delete 
after complete.

• To remove failed jobs while they are processing or printing, select 
Delete on job failure.

3. Click Submit. 

Note:  This option sustains enough free disk space for the duration of the print 
run and only affects the job that is currently printing.
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4. Select the resume button to resume the Process Queue and start the 
processing of your job.

Substitute Fonts
Select one of the following options:

Yes: to substitute a missing font with the default font set in the 
Settings window

No: to stop the job processing if the desired font is missing

Note:  For more information on managing fonts, see Managing Fonts on 
page 79.



200 Appendix A– Setting Parameters

APR

1. In the APR options area, select one of the following options:

• Print with high res: replaces low-resolution images in your job 
with high-resolution images that are located in a specified APR 
path.

• Print with low res: prints the job with the existing low-resolution 
images—for example, for proofing purposes.

2. In the Use APR mask from area, select one of the following options:

• PostScript image: uses the masking data contained in the low-
resolution image file.

• High res: uses the masking data contained in the high-resolution 
image file.

• Both: uses the masking data that is common to both high-
resolution and low-resolution image files. For example, if the 
images defined by the two sets of masking data overlap, the 
overlapping area is RIPed.

Note:  This parameter is available only if you have the Pro configuration.

Note:  If the masking data in the low-resolution image file defines a 
completely different part of an image than the masking data in the 
high-resolution file, no masking data is used.
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Job Flow
The Job Flow parameter enables you to specify a job flow for a job that is 
imported to the Spire CX250 color server from the network or from the 
Spire CX250 color server folders.

Select one of the job flow options:

Process & Print: to set the Spire CX250 color server to RIP the PDL 
files, print them, and store them in the Storage window (unless the 
Job Deletion parameter is set to Delete after Complete)

Process & Store: to RIP the PDL files and move them to the Storage 
window as RTP jobs

Spool & Store: places the PDL files directly into the Storage window 
without processing them. 

Preflight
Select Run Preflight check to check the status of key job components 
before the job is sent for printing.

Your job is RIPed and the missing components are identified. 

You can set the preflight to detect the following problems:

High-resolution images

Incorrect links to the high-resolution images folder

Missing fonts

Spot colors that are not defined in the Spire CX250 color server 
spot color dictionary

The results of the preflight check are displayed in a Preflight Report. To 
generate this report, right-click the RTP job in the Storage window and 
select Preflight Report. For more information on the Preflight Report, see 
Preflight Report on page 103.

Note:   This option can be defined only through the PPD parameters of the 
virtual printer.

Note:   If a job component is missing, the job fails before it is RIPed and an alert 
message appears. The job is transferred to the Storage window. Information 
about missing components will appear in the Job History window.
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Job Info
This parameter provides the following information:

• Job Title: Original name of the file related to this job

• Sender: User name of the system from which this job originated

• Account: Account number of a specific customer or group

• Recipient: Name of customer

• Job Comments: Any special instructions that you want to include with 
your job

Split to booklets

The Split to booklets parameter enables you to split a PostScript, PDF, or 
large VI job that does not have a booklet structure into booklets. 

1. In the Split to booklets options area, select Yes.

2. In the Number of pages per booklet box, type the desired number.

PDF/PS Optimization
Select this check box if you have a PDF job with repeated elements and 
want to significantly decrease processing time by applying the PDF 
workflow. 

The PDF workflow caches the repeated elements in the PDF once, and 
reuses them as much as required without repeated processing.

Note:  This parameter is available only if you have the Pro configuration. 

Note:  Unexpected results might occur when you use this option for VI jobs that 
already have a booklet structure.

Note:  If the specified number of pages per booklet is not sufficient to 
produce complete booklets and there are a few pages left over, the last 
pages form a booklet containing less pages than specified.

Note:  Verify that in your Acrobat Distiller settings, Optimize for Fast Web 
View is selected (in Acrobat 4.0 the corresponding option is Optimize PDF).
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The Finishing Tab

Admin. Page
The administration page contains job-related information such as the job 
title, the name of the sender, the date and time that the job was submitted, 
account information, and comments.

The administration page is printed in the same order as the job. For face-
down printing, the page is printed before each set; for face-up printing, the 
page is printed after each set.

To print an administration page:

Select the Print Admin. page check box, and set the specifications as 
desired.

Note:  If you change the options in the Admin. page options, you need to 
re-RIP.
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Slip Sheet
You can print slip sheets with your job and select a different paper set in 
which to print the slip sheet. If the job is collated, the slip sheet prints 
between sets. If the job is uncollated, the slip sheets prints between groups.

Select the Print slip sheet check box and select the relevant tray.

Front Cover
By default, your job is printed without a front cover. However, you can 
choose to print a front cover, and you can also select a different paper set. 

Select the Print front cover check box, and set the specifications as 
desired:

a. Select the relevant tray from the list.

b. In the Cover printing area, select one of the following options:

• None: prints a blank front cover

• Print on front side: prints the first page of the job as the cover page

• Print on both sides: prints the first two pages of the job as the 
cover page

Back Cover
By default, your job is printed without a back cover. However, you can 
choose to print a back cover, and you can also select a different paper set. 

1. Select the Print back cover check box, and set the specifications as 
desired.

2. In the Cover printing area, select one of the following options:

None: prints a blank back cover

Note:  A blank page is automatically inserted between the cover page 
and the first page of the job so that both sides of the cover page are 
defined, and the job starts on the next odd page.

Note:  A blank page is automatically inserted between the back cover 
and the last page of the job so that both sides of the back cover are 
defined.
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Print on back side: prints the last page of the job as the back cover

Print on both sides: prints the last two pages of the job as the back 
cover

Finisher
The Finisher parameter enables you to select the destination of the printed 
output.

Select an Output Tray:

SCT (simple catch tray)

OCT (offset catch tray)

• The Offset check box is selected by default. If you don’t want 
to use an offset between sets, clear this check box.

Top Tray

• The Offset check box is selected by default. If you don’t want 
to use an offset between sets, clear this check box.

• To punch holes, select the Puncher check box, and select the 
number of holes in the Type list.

Stacker

• The Offset check box is not selected by default. If you want to 
use an offset between sets, select this check box.

• To use staples, select the Stapler check box, and in the Position 
list, select the staple position.

• To punch holes, select the Puncher check box, and select the 
number of holes in the Type list.

Booklet Maker

• To use staples, select the Stapler check box, and in the Position 
list, select the staple position.

Note:  The available stapling methods for PostScript files depend on the page 
orientation and size. The stapling methods for PDF files depend on the page size.
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The Exceptions Tab
The Exceptions tab enables you to add and delete page exceptions and 
inserts. Exceptions are special pages in a job for which you want to assign 
different paper stock. For example, you can assign a different paper stock 
for each chapter within a book. 

Inserts are blank pages of a selected paper stock that are assigned to a job 
after a specified number of pages. For example, you can add blank pages 
between sections in a brochure.

Managing Exceptions
You can add and delete exceptions on the Exceptions tab.

To add exceptions to a job:

1. In the Exception area, click the Add button .

2. In the From and To boxes, type the desired page range for the 
exception.

3. In the Tray list, select the required tray. If you select Auto, any tray 
with the specific paper size will be used.



Setting Parameters in the Job Parameters Window 207

4. Click Apply.

The exception is added to the Exception area.

To delete an exception:

In the Exception area, select the desired exception and click the 

Remove button .

Managing Inserts

To add an insert:

1. In the Insert area, click the Add button .

2. In the After page box, type the number of the page that will precede 
the insert. 

3. In the Quantity box, type the number of inserts that you want.

4. In the Paper size list, select the desired paper stock size. If you select 
Custom, type the height in the H box and width in the W box, and 
then select LEF or SEF.

5. In the Media type list, select the desired paper stock type. The default 
setting is Use Printer Settings. When this option is selected, your job 
is printed on the media type that is defined on the Xerox DocuColor 
240/250 printer-copier.

6. In the Tray list, select the required tray. If you select Auto, any tray 
with the specific paper size will be used.

7. Click Apply.

The insert is added to the Insert area.

To remove an insert:

In the Insert area, select the desired insert and click the Remove button 

.
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Setting PPD File Parameters 
You can set job parameters from a client workstation using the PPD file, or 
you can define a virtual printer with predefined PPD file settings.

To print a file from Windows, first set up a Spire CX250 color server 
network printer with the appropriate PPD file. The PPD file contains all 
the parameters and paper stock definitions for the printer and enables you 
to print your file properly. 

Table 12 lists the PPD file parameters available.

Notes:

• In the PPD file, the Printer’s Default option is selected for all PPD file 
parameters. The Printer’s Default option corresponds to the settings of the 
currently selected virtual printer.

• Print settings defined in the job file override the settings of the virtual printer.

• To ensure that grayscale images created in RGB applications (such as 
PowerPoint) are counted as black and white instead of color in both the 
Spire CX250 color server and the Xerox DocuColor 240/250 printer-copier 
billing meters, select Gray RGB>Print grays using black toner in the PPD 
file.
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Table 12: PPD parameters

PPD Parameter For more information

Paper Size See Paper Size on page 179.

Media Type See Media Type on page 180.

Media Image Quality See Media Type on page 180.

Gloss Enhanced See Media Type on page 180.

Side-2 Printing See Media Type on page 180.

Print Method See Print Method on page 177.

Print order See Print Order on page 177.

Delivery See Delivery on page 177.

Collation See Collation on page 177.

Image Scale See Image Scale on page 178.

Color Mode See Color Mode on page 185.

Text and Line Quality See Text /Line Quality on page 181.

Image Quality See Image Quality on page 182.

Trapping See Trapping on page 182.

Black Overprint See Black Overprint on page 183.

PS Overprint See PS Overprint on page 183.

Brightness See Color Adjustments on page 189.

Contrast See Color Adjustments on page 189.

RGB Workflow See RGB Workflow on page 185.

Rendering Intent for RGB See RGB Workflow on page 185.

CMYK Workflow See CMYK Workflow on page 185.

Destination profile See Destination Profile on page 188.
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Emulate Source Paper Tint See CMYK Workflow on page 185.

Preserve Pure Colors See CMYK Workflow on page 185.

Rendering Intent for CMYK See CMYK Workflow on page 185.

Ink Saving (GCR) See Ink Saving (GCR) on page 189.

Calibration See Calibration on page 188.

Screening Method See Screening on page 188.

Automatic Deletion See Job Deletion on page 198.

APR See APR on page 200.

Job Flow See Job Flow on page 201.

Split to Booklets See Split to booklets on page 202.

Admin Page See Admin. Page on page 203.

Slip Sheet See Slip Sheet on page 204.

Transparency Interleave See Media Type on page 180.

Finisher Module See Finisher on page 205.

Finisher Offset See Finisher on page 205.

Punch Options See Finisher on page 205.

Staple Options See Finisher on page 205.

Booklet Stapling See Finisher on page 205.

Rotate 180 See Rotate 180 on page 178.

Table 12: PPD parameters

PPD Parameter For more information
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Overview
This chapter describes when and how to back up and restore the entire 
operating system and software (including the current job list database) on 
your computer, as well as when and how to reinstall the Spire Application 
software on your Spire CX250 color server.

Backing up the software on a regular basis (weekly) is always 
recommended so that a working copy can be used for recovery, if 
necessary. Performing the restore procedure requires a previous backup. 
To ensure a successful recovery:

• Save a copy of the backup, either on the network or on an external 
device, to prevent loss of data in case your system disk becomes 
corrupted. 

• Perform the backup and recovery procedure at any time that you want 
to back up and restore the Spire CX250 color server system partition 
and the job list database.

The following scenarios will assist you in determining when to use the 
backup and restore procedures.

Note:  To back up and restore the Spire CX250 color server software on the 
CX250, you must be connected to the Spire CX250 color server via the Remote 
Desktop Connection. 

Note:  Windows XP activation is not required.

Procedure Use Windows 
XP 
Activation

Backup For future use, when you want to revert 
back to a specific configuration.

Not 
required

Restore Operating system fails

Operating system’s performance is low

Not 
required
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Preloaded Software
The Spire CX250 color server is delivered to the customer site preloaded 
with the following software and configuration:

• Microsoft Windows XP Professional with SP2

• Internet Explorer 6.0 

• Spire Application software 

• Adobe® Acrobat® 6.0

• Network Parameters (host name, IP address, network services and 
protocols)

• System backup (partitions C and D)

Disk Configuration
The following table outlines the Spire CX250 color server disk 
configuration:

Disk 0 C: (6 GB)
Windows XP 
Professional 
software

CX250 Application 
software

 D: (~60 GB)
Spool files
Shared files
Output directory 
files
Job list backup 
folder

E: (12 GB)
Backup

• Factory Default—
read-only file 
(FD.GHO)
(FDxxx.GHS)

• Last Image 
(LI.GHO)
(LIxxx.GHS)

Boot partition: 
(24 MB)
Used during system 
backup

Disk 1 Image storage (RAID set)
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Backing Up and Restoring the Software

We recommend that you restore the software on your Spire CX250 color 
server after an unrecoverable system crash or when the operating system’s 
performance is low.

When you back up the Spire CX250 color server system partition 
(partition C), all the operating system files are copied to partition E 
(LI.GHO). 

The backup and restore procedures for the Spire CX250 color server do 
not require Windows XP Professional activation, and are not related to the 
system reinstallation. The procedures can be performed at any time that 
you want to backup and restore your Spire CX250 color server system 
partition, and backup and restore your job list database.

To restore the Last Image configuration, you first need to back up the 
CX250 configuration (partition C:). 

The procedures for backing up and restoring the software are described in 
detail in the following sections. 

Attention:  To ensure a successful backup, there must be at least 650 MB of 
disk space available in partition C.

Attention:  Before performing the backup procedure, make sure that your 
computer’s configuration is the one that you want to use when restoring the 
system.

Note:  Restoring the Factory Default configuration does not include the job list 
database. Restoring the Last Image configuration may not include the most 
recent job list database.

Note:  To enable the restoration of customer settings and job data, we 
recommend that you back up the Spire CX250 color server configuration and 
other information before performing the recovery procedure. 

Attention:  Once you have backed up all the required information to your local 
disk, move this information to an external device or to a network (you cannot 
back up directly to an external device or network).
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Backing Up the CX250 Last Image Configuration
The Spire CX250 color server includes two backup configurations.

You can back up the Spire CX250 color server system partition (Last 
Image) at any time.

When you back up your Spire CX250 color server system partition, 
Norton Ghost copies the files from partition C to the Last Image file on 
partition E.

1. Turn on your client PC, Mac client, or portable workstation.

2. After the Spire Application workspace appears, quit the software and 
wait for the Spire icon to disappear from the desktop taskbar.

Configuration Description

Last Image 
(system backup)

Partition C only—this is the default backup 
configuration

Factory Default Default settings are backed up in the factory and 
cannot be altered (partitions C and D)

Attention:  To ensure a successful backup, there must be at least 650 MB of 
disk space available in partition C.

Note:  If you are already logged on your system and the Spire Application 
workspace is open, quit the Spire Application software, wait for the Spire icon to 
disappear from the desktop taskbar, and then proceed to step 3. 

Before After

Note:  To back up the Last Image configuration on the CX250 basic 
configuration, you must be connected to the Spire CX250 color server via 
the Remote Desktop Connection. 
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3. On the desktop, select Start > CX250 > CX250 Tools > System Backup 
and Restore > Start system backup.

4. The system checks whether there is adequate space on partition C to 
perform the backup.

a. If there is adequate disk space on partition C (at least 650 MB) to 
perform the backup, the following message appears:

Click Yes to continue or No to cancel, and proceed to step 5.

Note:  This process may take several minutes to complete. On the Spire 
CX250 color server, LED 5 illuminates steady green.
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b. If there is not adequate disk space to perform the backup, the 
following message appears:

Click OK to continue, free disk space on Partition C, and then 
continue the backup procedure from step 3.

5. The Spire CX250 color server restarts and the Norton Ghost window 
appears.

The files from partition C are copied to the Last Image file on 
partition E. The process takes about 10 minutes to complete.

The Spire CX250 color server restarts and the Windows XP desktop 
appears.

You have completed Backing Up the CX250 Last Image Configuration.

Note:  On the CX250 Control Station and Pro configurations, the 
appearance of the Windows XP desktop indicates that a successful backup 
has been performed. 

On the CX250 basic configuration, when the Spire CX250 color server 
restarts, your current RDC session terminates. To determine that a successful 
backup was completed, do one of the following:

• Wait ten minutes and reconnect to the Spire CX250 color server via the 
RDC utility. If you are able to connect to the server, the backup 
succeeded.

• On the CX250 basic configuration, check LEDs 3 and 5. If both LEDs 
illuminate steady green, the backup succeeded.

Tip: To copy the files to an external device, select Start > Run, type E: 
and click OK. Copy only the files located on E:LI.GHO and E:LIxxx.GHO 
(Last Image configurations) or E:FD.GHO and E:FDxxx.GHS (Factory 
Default configurations).
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Backing Up the Job List Database
If you back up the CX250 Last Image configuration (see Backing Up the 
CX250 Last Image Configuration on page 215), your job list database is also 
backed up. If, at some later date, you restore the configuration, the original 
job list database will be restored, thus replacing your current job list 
database.

1. Turn on your client PC, Mac client, or portable workstation.

2. Quit the Spire Application software and wait for the Spire icon to 
disappear from the desktop taskbar.

3. On the Windows desktop, double-click My Computer, and locate 
D:\Backup\Scripts.

Note:  If you are already logged on to your system and the Spire Application 
workspace is open, quit the Spire Application software and proceed to step 3.

Before After

Note:  To back up the job list database on the CX250 basic configuration, 
you must be connected to the Spire CX250 color server via the Remote 
Desktop Connection. 
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4. In the D:\Backup\Scripts folder, double-click Backup_Joblist.bat.

5. When the backup is complete, the following message appears.
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6. Make sure that the folders created in D:\Backup have the latest 
modification date.

7. Press any key to continue.
You have completed Backing Up the CX250 Last Image Configuration.

Restoring the Spire CX250 Color Server
Performing the restore procedure requires a previous backup. Before 
restoring the Spire CX250 color server system partition, we recommend 
that you back up any current important jobs, using the procedure 
described in Backing Up the CX250 Last Image Configuration on page 215. 
If you want to restore the information from the Last Image file on 
partition E back to partition C, the current job list will be replaced with the 
old job list that was saved while backing up partition C.

Note:  The backup comprises a group of folders that are created the first 
time you back up the job list database.

Note:  If the job list database was not backed up or cannot be restored, you must 
format the image disk before performing the restore procedure. For more 
information, see Formatting the Image Disk on page 247.
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Verifying the Current Recovery Type
The Spire CX250 color server includes two options for restoring the 
system:

• Restoring the Last Image configuration

• Restoring the Factory Default configuration

Before performing the recovery procedure, the system must be in the 
configuration mode that you want to recover.

To verify the current recovery type:

1. Using the tip of a pen or similar object, press the RCVR (OS recovery) 
button on the front of the Spire CX250 color server.

2. From your client PC, Mac client, or portable workstation, connect to 
the Spire CX250 color server via the RDC utility. 

3. On the Spire CX250 color server’s desktop, select CX250  > 
CX250 Tools > System Backup and Restore > Show current recovery 
type.

Note:  The Spire CX250 color server backup configuration default is the Last 
Image configuration.

Note:  This step is required only on the CX250 basic configuration.
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When the following windows appears, click OK. 

Restoring the Last Image Configuration
To restore the Last Image configuration, the operating system must be in 
Last Image mode. See Verifying the Current Recovery Type on page 221.

1. Turn on the Spire CX250 color server.

2. If required, return the ghost file or files that you moved to an external 
device to partition E.

3. Using the tip of a pen or similar object, press the RCVR (OS recovery) 
button on the front of the Spire CX250 color server.

4. From your client PC, Mac client, or portable workstation, connect to 
the Spire CX250 color server via the RDC utility. 

Note:  If the current recovery type is Factory Default, the message Current 
Recovery type is Factory Default appears.

Note:  If the Spire CX250 color server is on and the Spire Application 
workspace is open, quit the Spire Application software and wait for the Spire 
icon to disappear from the desktop taskbar.

Before After

Important:  If you only want to verify the current recovery type, but do not 
want to initiate the recovery process, press the RCVR (OS recovery) button 
again to exit the recovery mode (LED 7 turns off).

Note:  You can change the configuration only when the operating system 
recovery mode is initiated (LED 7 illuminates steady orange).

Note:  This step is required only on the CX250 basic configuration.



Backing Up and Restoring the Software 223

5. When the RCVR LED (7) on the Spire CX250 color server illuminates 
steady orange, go to Start > CX250 > CX250 Tools > System Backup 
and Restore > Set Last Image recovery.

6. When the OS confirmation message appears, click OK.

7. Press the green On/Off button continuously for 4-5 seconds to restart 
the Spire CX250 color server.

Ghost copies the files from partition E to partition C. This process 
takes approximately 5-10 minutes.

8. When Ghost finishes copying the files and the RVCR LED (7) 
illuminates steady green, using the tip of a pen or similar object, press 
the RCVR button to exit recovery mode.

9. Restart the Spire CX250 color server.

a. Press the green On/Off button continuously for 4-5 seconds. The 
Spire CX250 color server shuts down.

b. Press the green On/Off button again. LED 1 illuminates steady 
green and the Spire CX250 color server restarts.

The backed up file runs, and the Spire Application software starts.

10. A system message may appear requesting you to restart the computer.

a. Quit the Spire Application software.

b. Click Yes to restart your computer.
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Restoring the Factory Default Configuration
To restore the Factory Default configuration, the operating system must be 
in Factory Default mode. See Verifying the Current Recovery Type on 
page 221.

1. Turn on the Spire CX250 color server.

2. If required, return the ghost file or files that you moved to an external 
device to partition E.

3. Using the tip of a pen or similar object, press the RCVR (OS recovery) 
button on the Spire CX250 color server.

4. From your client PC, Mac client, or portable workstation, connect to 
the Spire CX250 color server via the RDC utility. 

Note:  The Spire CX250 color server backup configuration default is the Last 
Image configuration.

Note:  If the Spire CX250 color server is on and the Spire Application 
workspace is open, quit the Spire Application software and wait for the Spire 
icon to disappear from the desktop taskbar.

Before After

Important:  If you only want to verify the current recovery type, but do not 
want to initiate the recovery process, press the RCVR (OS recovery) button 
again to exit the recovery mode (LED 7 turns off).

Note:  You can change the configuration only when the operating system 
recovery mode is initiated (LED 7 illuminates steady orange).

Note:  This step is required only on the CX250 basic configuration.



Backing Up and Restoring the Software 225

5. When the RCVR LED (7) illuminates steady orange, go to Start > 
CX250 > CX250 Tools > System Backup and Restore > Set Factory 
Default recovery.

6. When the OS confirmation message appears, click OK.

7. Press the green On/Off button continuously for 4-5 seconds to restart 
the Spire CX250 color server.

Ghost copies the files from partition E to partition C, and then from 
partition E to partition D. This process takes approximately 
10-15 minutes.

8. When Ghost finishes copying the files and the RVCR LED (7) 
illuminates steady green, using the tip of a pen or similar object, press 
the RCVR button to exit recovery mode.
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9. Restart the Spire CX250 color server.

a. Press the green On/Off button continuously for 4-5 seconds. The 
Spire CX250 color server shuts down.

b. Press the green On/Off button again. LED 1 illuminates steady 
green and the Spire CX250 color server restarts.

The backed up file runs, and the Spire Application software starts.

10. A system message may appear requesting you to restart the computer.

a. Quit the Spire Application software.

b. Click Yes to restart your computer.

You have completed Restoring the Spire CX250 Color Server.

Restoring the Job List Database

When you restore the Spire CX250 color server software and configuration 
that you previously backed up, you are replacing the current job list 
database with your original job list database.

1. Turn on your client PC, Mac client, or portable workstation.

2. Quit the Spire CX250 color server software and wait for the Spire icon 
to disappear from the desktop taskbar.

3. On the Windows desktop, double-click My Computer, and locate 
D:\Backup\Scripts.

Note:  This procedure is valid only if the last restore made was the Last Image 
configuration. Restoring the Factory Default configuration erases the job list 
database.

Note:  If you are already logged on to your system and the Spire Application 
workspace is open, quit the Spire Application software, wait for the Spire icon to 
disappear from the desktop taskbar, and then proceed to step 3.

Before After

Note:  To restore the job list database on the CX250 basic configuration, 
you must be connected to the Spire CX250 color server via the Remote 
Desktop Connection. 
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4. In the D:\Backup\Scripts folder, double-click Restore_Joblist.bat.

The following message appears.
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5. Press Y to continue.

The following window appears.

6. Press any key to continue. 
You have completed Restoring the Job List Database.
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Adding the Spire CX250 Color Server to a Domain
This procedure should be performed by a System Administrator. It 
contains the following major tasks:

1. Uninstalling the Spire Application (Spire CX250 color server) 
software.

2. Adding the Spire CX250 color server to the Microsoft Active 
Directory® domain, and assigning a user name and password.

3. Ensuring that the user is included in the Spire CX250 color server’s 
Administrator’s group (local group).

4. Logging on to the domain, reinstalling the Spire Application (Spire 
CX250 color server) software, and then assigning printing 
permissions on the shared virtual printers, as required by your site 
policy.

For more information about adding the Spire CX250 color server to the Active 
Directory, go to www.microsoft.com.

http//www.microsoft.com 
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Reinstalling the Spire Application Software

Before you can reinstall the Spire Application software, you must uninstall 
the current version.

Uninstalling the Spire Application Software

1. Turn on your client PC, Mac client, or portable workstation and 
connect to the Spire CX250 color server.

Note:  To install and uninstall the Spire Application software on the CX250 basic 
configuration, you must be connected to the Spire CX250 color server via the 
Remote Desktop Connection. 

Note:  The uninstalling process terminates your current RDC session. To open a 
new session, you must reconnect your client PC, Mac client, or portable 
workstation to the Spire CX250 color server.

Note:  If the Spire CX250 color server is on and the Spire Application 
workspace is open, quit the Spire Application software and wait for the Spire 
icon to disappear from the desktop taskbar.

Before After
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2. On the Spire CX250 color server desktop, select Start > Settings > 
Control Panel > Add or Remove Programs.

3. In the Add or Remove Programs window, select CX250 and click the 
Change/Remove button.

4. The message Do you want to uninstall it now? appears. Click 
OK.

5. The following window appears. Click Yes.

6. The following window appears. Click OK.
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7. When the InstallShield Wizard finishes uninstalling the Spire 
Application and Spire GUI, the following window appears. Select the 
Yes, I want to restart my computer now. option and click Finish.

The Spire CX250 color server restarts and your current RDC session 
terminates.
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Installing the Spire Application Software

1. On the Spire CX250 color server desktop, double-click My Computer.

2. Insert CD #2 (Spire Application software) into the CD/DVD-ROM 
drive on your local client PC, Mac client, or portable workstation.

3. Under Other, select the CD/DVD-ROM drive. This is your local CD/
DVD-ROM drive that is published on the Spire CX250 color server.

4. Double-click the <Drive>\CX250\Setup.exe file and follow all the 
installation steps in the InstallShield Wizard.

Note:  To install the Spire Application software on the CX250 basic 
configuration, you must be connected to the Spire CX250 color server via the 
Remote Desktop Connection. 

Note:  Installing the Spire Application software via the RDC utility may take 
up to 15 minutes.
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5. When the InstallShield Wizard finishes installing the Spire 
Application software, the following window appears. Select the Yes, I 
want to restart my computer now. option and click Finish.

The Spire CX250 color server restarts and your current RDC session 
terminates.

You have completed Installing the Spire Application Software.

Configuring the McAfee VirusScan (Optional)

The current Creo recommended virus protection software is McAfee 
VirusScan Enterprise version 8.0.0. After installing McAfee VirusScan, 
perform the following configuration procedures. 

Note:  To open a new session, you must reconnect your client PC, Mac 
client, or portable workstation to the Spire CX250 color server.

Note:  McAfee VirusScan Enterprise version 8.0.0 is supported on Windows 
2000 and Windows XP only. Use version 7.1 for earlier software versions.

Important:  Running McAfee VirusScan could slow down the process time and 
affect the overall performance of the server.
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Creo will continue to update their virus protection software 
recommendations according to software performance and market 
availability.

It is the responsibility of the site manager to obtain, once a year, the latest 
version of the anti-virus software and installation procedure. The site 
manager must also regularly download the latest anti-virus definitions 
from the relevant Internet site. 

To configure the McAfee VirusScan, perform the following procedure.

Configuring the Scan All Fixed Disks Settings
1. From the taskbar, right-click the VShield icon and select VirusScan 

Console:

2. In the Task column, right-click Scan All Fixed Disks and select 
Properties.

3. Click the Detection tab.

Note:  The following McAfee VirusScan software configuration procedure is 
subject to change without notice and the relevant documentation will not be 
updated.
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4. In the What not to scan area, click Exclusions.
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5. Click Add.

The following dialog box appears.

6. Click Browse.

7. In the Browse for Folder window, locate the D:\Output folder and 
click OK.

The D:\Output folder path appears.
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8. Select the Also exclude subfolders check box and click OK.

9. In the Set Exclusions dialog box, click OK, and again click OK.

Configuring the On-Access Scan Settings
1. Return to the VirusScan Console window.

2. In the Task area, right-click On-Access Scanner and select Properties.

3. On the left of the window, click the All Processes icon.
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4. Click the Detection tab.

5. In the What not to scan area, click Exclusions.

The following dialog box appears:
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6. Click Add.

7. Click Browse.

8. In the Browse for Folder window, locate the D:\Output folder and 
click OK.

The D:\Output folder path appears.

9. Select the Also exclude subfolders check box and click OK.
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10. In the Set Exclusions dialog box, click OK.

11. In the VirusScan On-Access Scan Properties window, click OK.

You have completed configuring the On-Access Scan settings.

Installing and Configuring Novell Client 
The following procedures are relevant only for customers who have a 
Novell® network running IPX protocol.

Installing Novell Client for Spire CX250 Color Server
1. Close the Spire CX250 color server workspace and the Spire CX250 

color server software.

2. Close all other software programs.

3. On the Windows desktop, select Start > CX250 > CX250 Tools > Novell 
Client Installation.

The following window appears.
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4. Click Install.

5. Click Reboot.

6. You have completed Installing Novell Client for Spire CX250 Color 
Server. Proceed to Configuring Novell Client for Spire CX250 Color 
Server.

Configuring Novell Client for Spire CX250 Color Server
1. After the system restarts, the Novell Setup dialog box appears.

2. Type the Tree Name. 
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3. If you do not know the name, click Browse.

4. Double-click the appropriate Tree Name.
The Tree Name appears in the Novell Setup window.

5. Type the Context Name. 

6. If you do not know the name, click Browse.

7. Double-click the appropriate Context Name.
The Context Name appears in the Novell Setup window.

8. Click OK.
The Spire CX250 color server workspace appears. 

You have completed Installing and Configuring Novell Client.
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Uninstalling Novell Client for Spire CX250 Color Server
Uninstall Novell Client if you no longer operate a Novell network running 
IPX protocol.

1. Close the Spire CX250 color server workspace and the Spire CX250 
color server software.

2. Close all other software programs.

3. Right-click My Network Places and select Properties.

4. Right-click Local Area Connection and select Properties.

5. Make sure the Novell Client for Windows check box is selected, and 
then click the Uninstall button.

6. Click Yes twice.
The Spire CX250 color server restarts.
You have completed Uninstalling Novell Client for Spire CX250 Color 
Server.
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Backing Up the CX250 Last Image Configuration
The Spire CX250 color server includes two backup configurations.

You can back up the Spire CX250 color server system partition (Last 
Image) at any time.

When you back up your Spire CX250 color server system partition, Norton 
Ghost copies the files from partition C to the Last Image file on partition E.

1. Turn on your client PC, Mac client, or portable workstation.

2. After the Spire Application appears, exit the workspace.

3. On the desktop, select Start > CX250 > CX250 Tools > 
System_Backup&Restore > System Backup.

4. The following confirmation message appears:

Configuration Description

Last Image 
(system backup)

Partition C only

Factory Default Default settings are backed up in the factory and 
cannot be altered (partitions C and D)

Note:  If you are already logged on your system and the Spire Application 
workspace is open, exit the workspace. 

Note:  To back up the Last Image configuration on the CX250, you must be 
connected to the Spire CX250 color server via the Remote Desktop 
Connection.  
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This operation will replace your current backup file 
with a new one. Do you wish to continue?
Note: The system will reboot twice and remain offline 
for several minutes during this process.

Click Yes to continue or No to cancel.

5. The Spire CX250 color server restarts and the Norton Ghost window 
appears.

The files from partition C are copied to the Last Image file on 
partition E. The process takes about five minutes to complete.

The server restarts and the Windows XP desktop appears.

You have completed Backing Up the CX250 Last Image Configuration.

Performing a Test Print

1. From the File menu select Import Job.

2. Locate the ATF_A3.ps file at:
D:\Sample_Files\Color Files\ATF Europe (A4_A3)\ATF_A3.ps,

or locate the ATF_tab.ps file at:
D:\Sample_Files\Color Files\ATF US (Letter_Tabloid)\ATF_Tab.ps.

3. Double-click the file to add it to the list for importing. 

4. In the Published Printer list, select ProcessPrint.

Note:  The appearance of the Windows XP desktop indicates a that 
successful backup has been performed. 

Tip: To copy the files to an external device, select Start > Run, type E: 
and click OK. Copy only the files located on E:LI.GHO and E:LIxxx.GHO 
(Last Image configurations) or E:FD.GHO and E:FDxxx.GHS (Factory 
Default configurations).

Note:  To import a file and perform a test print on the CX250, you must be 
connected to the remote server via the Remote Desktop Connection. See 
Working from the Remote Desktop Application on page 16. 
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5. Click Import.
The file is processed, printed, and sent to the Storage window.

Formatting the Image Disk

Perform the following procedure when suggested as a recovery action.

1. Close all software programs and wait for them to shut down 
completely.

2. Select Start > CX250 > CX250 Tools > Format Image Disks.

Note:  If the job is not printed or is waiting in the Print queue, check that the 
finishing device is set properly in the Job Parameters window, Finisher tab.

Note:  To format an image disk on the CX250 configuration, you must be 
connected to a client PC, Mac client, or portable workstation via the Remote 
Desktop Connection. See Working from the Remote Desktop Application on 
page 16.

Important:  Formatting erases all data stored in the Storage folder. It is 
recommended that either an ONSA or your system administrator back up the 
customer’s data, if possible, to an external device or network.
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The following message appears.

3. Close all open windows, if required, and click OK.

 

4. Click OK.

The following message appears.

5. Click OK.

 

6. Click OK.

7. To enable the changes to take effect, restart your computer.



24 bit/3 byte image An image can be either RGB or CMY and each of the three colors uses 
1 byte or 8 bits of data. Since 3 bytes equals 24 bits, these images are 
also known as 24 bit images. This system is used for high quality video 
imaging and scanning. For process color printing, a fourth color 
(black) is added for optimum effect. 

32 bit/4 byte image An image that uses 8 bits each for CMYK pixels, or 8 bits for each RGB 
pixel and 8 pixels for a mask layer or other future use. Since 4 byte 
equal 32 bits, these images are also known as 32 bit images. An 8 bit 
CMYK image is the minimum required for high quality print 
reproduction. 

4 color printing Color reproduction method used to create full color output by 
overlaying cyan, magenta, yellow and black inks.

8 bit/1 byte image An image limited to 256 tones of one color or 256 different colors. 
Since 1 byte contains 8 bits and each bit has two choices, 1 byte equals 
28 choices or 256 possibilities.

Absolute Colorimetric A rendering intent method similar to Relative Colorimetric except 
that it does not make adjustments according to the white point. In 
this method, colors that do not fit within the output color space are 
rendered at the extremes of the output color space. Colors that fall 
inside the output color space are matched very accurately. 
This method is valuable for representing “signature colors“. Colors 
that are highly identified with a commercial product such as the cyan 
in the Creo logo.

Additive color model Color system in which the picture is composed of the combination of 
Red (R), Green (G) and Blue (B) light transmitted by the original 
subject. Effective for monitors and TV's but not for print. Scanners 
normally first scan in RGB and it is converted into CMYK for 
printing. See also RGB, CMYK, Process colors, Subtractive color 
model.

Amplitude Modulation Halftone screening, as opposed to FM screening, has dots of variable 
size with equal spacing between dot centers.

Glossary
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Anti-Aliasing A step effect in which angled lines or curved edges of elements in an 
electronic image look broken or jagged, as a result of producing it in 
a grid format. Increasing resolution can reduce this effect or using a 
technique called anti-aliasing where the edges are softened.

APR Creo's Automatic Picture Replacement workflow. In this workflow, 
two versions of a file are created - a high-resolution file and a low-
resolution file called PSImage. The latter is used for positioning and 
manipulation within a DTP application. The low-resolution file is 
replaced automatically by the high-resolution version during the RIP 
process. See also PSImage.

Binding The process by which pages of a book or other publication are 
attached to one another.

Bit Abbreviation of binary digits. The smallest unit of information used 
to store information in a computer. Bits are expressed as a binary 
notation, that is, in ones and zeros.

Bitmap graphics An image composed of individual pixels. The color value and position 
of each pixel are individually described in bits and bytes of computer 
memory. It is called a bitmap because it is effectively a map of bits. See 
also Raster file.

Bleed An extra amount of printed image, which extends beyond the trim 
edge of the sheet or page.

Booklet VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of several pages, but the entire 
document is targeted at a specific individual or address. VI jobs 
include elements that may differ from booklet to booklet, including 
text, graphics, pictures and page backgrounds. 

Butt To join without overlapping or space between.

Byte A grouping of 8 bits of stored information, giving 256 levels of data. 
Each byte represents a value or character such as a letter or a number. 
In a color system, a byte can describe one out of 256 distinct shades. 

CIE Abbreviation for Commission Internationale d'Eclairage. This body 
was created for the study of illumination problems. CIE color 
coordinates specify proportions of the three additive colors required 
to produce any hue and are used for comparative color measurement.



Glossary 251

CMYK The process colors - Cyan, Magenta, Yellow and Black. See also Color 
separations, Process colors, and Subtractive color model.

Color gamut The range of colors possible with any color system. 

Color separations Separate films are prepared for each of the process printing inks - 
cyan, magenta, yellow and black. These films are used to prepare the 
printing plates for printing on press. See also CMYK.

CSA (Color Space Array) Color Space Array is the spectrum of specific variants of a color 
model with a specific gamut or color range. For example, within the 
color model RGB, there are numerous color spaces, such as Apple 
RGB, sRGB, and Adobe RGB. While each of these define color by the 
same three axes (R, G, and B), they differ in gamut and other 
specifications. CSA is comprised of a three-dimensional geometric 
representation of colors that can be seen or generated using a certain 
color model and are quantitatively measured. Source CSA is to be 
used only under the assumption that the upstream color workflow 
was managed and monitored. Otherwise it should be replaced with a 
Creo profile, which is the default.

CSA Profiles There are three CSA profiles with gammas of 1.8, 2.1 and 2.4. The 
higher the gamma, the darker the RGB appears. This workflow should 
be used when you have images from different sources, such as digital 
cameras, Internet, and scanners and you want the images to have the 
common RGB color spaces. 
Other possible CSA profiles are sRGB and Adobe RGB

Composite mode In composite mode, the data required to separate a page into its 
CMYK components is all contained within one single (composite) 
file. Brisque or PS/M then separates the file into CMYK as part of the 
conversion process. This processing mode is the fastest and most 
efficient in the majority of cases.

Creep The effect of middle pages of a folded signature extending slightly 
beyond outside pages, compensated by shingling. See also Shingling.

Crop To eliminate portions of an illustration or photography so the 
remainder is more clear, interesting or able to fit the layout.

CT Abbreviation for continuous tone. Color or black and white 
photographic images with tones that change gradually from dark to 
light (unlike the abrupt changes in linework). 
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DCS Abbreviation for Desktop Color Separation, an EPS format 
containing 5 files. Four of the files contain the color information for 
each of the CMYK colors and the fifth is a low-resolution composite 
file for use in electronic page layout. See also OPI.

Degradé A gradual blend or transition between colors. Also known as vignette 
or graduated blend (Vector drawing).

Digital front end system In electronic publishing, this is the workstation or group of 
workstations containing the applications software for preparing pages 
of type and graphics. In prepress, this is the workstation that gives 
access to the user for the operation of hardware. For example, proofer, 
platesetter, imagesetter.

Digital proof A black and white or color image reproduction made from digital 
information without producing intermediate films. It can be output 
as a digital hard proof using a peripheral output device or displayed as 
a digital soft proof on a video monitor.

Dot  The individual element of a halftone.

Dot area The percentage of an area covered by halftone dots ranging from no 
dots at 0% to a solid ink density at 100%. The size of a single dot is 
stated in a percentage of the area it occupies.

DTP Abbreviation for Desktop Publishing. The process of page production 
using personal computers, off-the-shelf software and an output 
device such as a printer or imagesetter. Usually, these components 
form a system that is driven by a device-independent page description 
language such as PostScript.

EPS Abbreviation for Encapsulated PostScript, a graphic file format used 
to transfer PostScript, graphic files from one program to another. It 
includes both a low-resolution preview and the high resolution 
PostScript image description. On the Macintosh, the preview is in 
PICT format, on the PC it is in TIFF format. Also known as EPSF.

Finishing stage Stage following the press process, which may include procedures such 
as laminating, perforating and varnishing.

Font A complete assortment of letters, numbers, punctuation marks, 
characters etc. of a given design and size.
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Frame A color overlap created intentionally at a color border so as to 
minimize the effects of misregistration. Also known as trap or grip. 
See also Trapping.

Frequency modulated screens A method of creating halftones where the spots are all the same size, 
but the frequency or number of dot changes in a given area. There are 
more dots in a dark area and fewer in a light area.

Frozen job A job for which the appropriate paper stock is not available, for 
example, the correct paper type, paper size or paper weight.

GCR Abbreviation for Gray Component Replacement. Method for 
reducing the CMY amounts that produce the gray component in a 
color, without changing the color hue. 

Graduated blend See Degradé.

Gravure printing  A printing method in which the image is engraved through a screen 
below the surface of a cylinder. The ink is transferred to paper when 
pressed to the cylinder. Gravure is used for very long print runs and 
on many substrates.

Gray component The amounts of CMY in a color, which result in neutral gray, based on 
the lowest separation value of the color. See also GCR.

Grayscale A scale of gray tones from white to black. Digitally, grayscale images 
have up to 256 different levels of gray. See also 8 bit/1 byte image.

Halftone A negative or positive image whereby detail of the image is 
reproduced with dots varying area but of uniform density. Creates the 
illusion of continuous tone when viewed with the naked eye.

Highlights The whitest portions of the original or reproduction that have no 
color cast. The highlight dot is ranged in the reproduction from the 
smallest printable dot to approximately 25%. See also Midtones and 
Shadows.

HSL Abbreviation of Hue, Saturation and Lightness. This is a color model, 
which specifies a color by its wavelength (Hue), chroma or purity of 
the color (Saturation) and value of its brightness (Lightness).

Image area Portion of a negative or plate corresponding to inking on paper. The 
portion of paper on which ink appears.
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Imposition The arranging of pages in a press form to ensure the correct order 
after the printed sheet is folded, bound and trimmed.

Ink jet proof A proof of a digital image printed by using jets that squirt minuscule 
drops of ink. Ink jet proofers can print onto a variety of surfaces.

Job Flow Job flow refers to the job parameter settings of selected virtual 
printers that are automatically applied to all jobs printed using that 
virtual printer. These settings determine how a sent or imported file 
is processed. For example, a file sent to a virtual printer with a Process 
& Print job flow will be RIPped, printed and stored in the Storage 
Folder. A file sent to a Process & Store job flow virtual printer will be 
RIPped and stored, without printing.

LEF A printer page orientation, where pages are delivered long edge first.

Laserwriter driver A part of the Macintosh system software which generates PostScript 
instructions from an application file when the Print command is 
activated.

Look-up table (LUT) A two or three-dimensional array of values stored for specified input-
output relationships. When one input value is known, the system can 
automatically determine the correct output value. For example, the 
system can find the needed dot size for a given set of printing 
conditions based on the stored gray level; color setups can be saved in 
color tables (color transformation tables) which are one of the many 
kinds of LUTs.

Linework Linework graphics are characterized by sharply defined lines and very 
clear transitions from one color to another. Linework is stored in the 
computer as a series of geometric (vector) drawing instructions.

Metamerism Metamerism occurs when two colors match under one light source, 
but appear different under another light source. Those two colors are 
called a metameric match. A metameric match might cause problems 
when trying to match proofs to press-sheets under different lighting 
conditions.

Midtones Density values of an image (original or reproduction) between the 
highlights and the shadows. In the reproduction, midtones are 
printed with dot areas between approximately 40% or 60%. See also 
Highlights and Shadows.
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Misregistration A situation common during printing where one or more of the color 
separations is slightly misaligned with regard to the others on press. 
Misregistration shows up as white gaps or tinted overlaps at the 
borders of color pairs. Colors containing such files are trapped to 
compensate for this possibility. On Continous Tone images, 
misregistration can lead to blurring. See also Overprint and Trapping.

Moiré An interference pattern caused by differences in halftone screen 
angles or rulings. In process color printing, screen angles are selected 
to minimize this pattern. If the angles are not correct, a pattern that 
distracts the eye from the picture may be produced.

Newton's rings Small concentric circles that can appear on film when two surfaces are 
closed together but not in perfect contact.

OPI Abbreviation of Open Prepress Interface. A prepress convention 
established by Aldus Corps. OPI refers to tags or place holders in 
source PostScript that point to TIFF or EPS images that have not been 
embedded in the PostScript. These images reside in other locations 
and are merged with the PostScript file when processed. Normally 
used for performing high res/low res image substitution (alternative 
to Creo APR).

Output resolution The number of laser dots per unit of linear measurement (millimeter, 
inch etc.) on film or paper. 

Output tone curve A graph showing the relationship of original input densities and the 
corresponding dot percentages on film. 

Overprint A technique, which overlaps colored elements to eliminate the 
appearance of gaps between elements caused by misregistration of the 
various separations during printing. For example, black text is 
normally set to overprint. See also Trapping and Misregistration.

PDL Printer Description Language files (for example, PostScript, PDF, 
EPS, VPS, VIPP). The CXP Color Server processes image files in PDL 
formats, converting them into a suitable Ready-To-Print format for 
direct, high-quality printing.
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Perceptual (Photographic) (Default for RGB) A rendering intent method which preserves the 
visual relationship among the colors as they are perceived by the 
human eye. In other words, all colors are proportionally scaled to fit 
the output gamut. All or most colors in the original are changed but 
the relationship between them does not change.
This method is recommended when working with realistic images 
such as photographs, including scans and images from stock 
photography CDs. 

PICT A Macintosh file format for bitmaps and vector graphics.

Pixels Contraction of Picture Element. The smallest element of a digital 
image.

PostScript A programming and page description language that has become 
industry standard for electronic publishing. It is used to describe the 
entire page, including both text graphics and images. PostScript is 
completely independent of the printing device. Developed by Adobe 
Systems, Inc.™

Prepress Generic term used to describe the processes involved in preparing 
images for printing. Includes the input, edit and output stages.

Printer description files PPDs (PostScript Printer Definition), and PDFs (Printer Definition 
Files). These files are used by the Macintosh applications to prepare 
page and documents for specific output devices.

Process colors The four ink colors used to reproduce full color images - cyan, 
magenta, yellow and black.

PSImage A low-resolution EPS file used in the Creo APR workflow. This file is 
used for positioning in page layout. Changes made to this file will be 
applied to the high-resolution file, which automatically replaces it 
shortly before exposure. See also APR.

Quartertone The tone area of an image influencing highlight detail and with 
density values between the white point and midtone. Typically, 
printed with a dot area near 25%. See also Highlights, Midtones, 
Shadows.

Raster file A file of data that was scanned, processed or output sequentially, bit 
by bit and line by line. Also known as a bitmap.
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Rasterization The translation of vector information into bitmap information. 
Bitmaps may also require a new rasterization to comply with the 
screening parameters (dot shape, dot size) of the imagesetter that will 
expose them on film. See also RIP and RIPing.

Register Fitting of two or more printing images or plates in exact alignment 
with each other.

Register marks Crosses or other targets applied to original copy prior to printing. 
Used for positioning films in register or for register of two or more 
colors in process printing.

Relative Colorimetric A rendering intent method in which colors that fall within the output 
color space remain the same. Only colors that fall outside are changed 
to the closest possible color within the output color space. 
When using this method, some closely related colors in the input 
color space can be mapped to a single color in the output color space. 
This reduces the number of colors in the image.

Rendering Intent All printers, monitors and scanners have a gamut or range of colors 
that they can output (or view in the case of a scanner). If a color needs 
to be output and is outside the gamut of the output device, it must be 
mapped or approximated to some other color, which exists within the 
gamut. Rendering Intent enables you to compress out-of-gamut 
colors into the color capability of the press you are using. You can set 
any rendering intent value for RGB elements by selecting the required 
from the Rendering intent options list. The default value for RGB is 
Perceptual (photographic). The default value for CMYK is Relative 
Colorimetric. 
There are several methods that can be used when translating colors 
from one color space to another. These methods are called Rendering 
Intents because they are optimized for various uses. When working 
with ICC profiles, it is important that you select the Rendering Intent 
that best preserves the important aspects of the image. Each rendering 
method specifies a CRD for color conversions. You can modify the 
rendering method to control the appearance of images, such as prints 
from office applications or RGB photographs from Photoshop.
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Resolution The number of pixels, points or dots per unit of linear measurement. 
For example, pixels per millimeter on a video display, number of dots 
per inch or millimeter on film or paper.

The resolution of an image is usually set the same vertically and 
horizontally. For example, a square millimeter with a resolution of 12 
contains 144 pixels. The higher the resolution, the more image detail 
is recorded and the larger the digital file size.

RGB Abbreviation for the additive primaries Red, Green and Blue. They 
are used in video monitors, scanning, and other uses where the light 
is direct and not reflected. The component colors are the three 
predominant colors in the visible light spectrum detected by the 
human eye. Combining these 3 colors together creates white light.

RIP Abbreviation for Raster Image Processor. This is a software program 
or hardware device that converts vector information into pixel 
information to be imaged on an output file. This output file is imaged 
based on commands from the page description language.

RIPing The process of rastering or converting bitmaps and vector graphics 
into raster images suitable to the screening parameters of the output 
device. Files are RIPed prior to exposure or plotting.

Saturated color A color where the high and medium values approach 100%. In a 
saturated clean color, the values of the wanted colors are near 100% 
and the value of the unwanted color is near 0%. For example, when 
the color is red, 5% cyan, 90% magenta, 80% yellow is more saturated 
than 30% cyan, 90% magenta, 80% yellow.

Saturated (presentation) A rendering intent method which scales all colors to the strongest 
saturation possible. The relative saturation is maintained from one 
color space to another.
This rendering style option is optimal for artwork and graphs in 
presentations. In many cases, this style option can be used for mixed 
pages that contain both presentation graphics and photographs.

Saturation  The strength of a color.

Screen angle The angle of rows of halftone dots represented in degrees. During 
output of films for reproduction, the dot arrangement of each 
separation film is placed at a distinct and different angle to the other 
separations. See also Moiré.
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Screen rulings The number of rows of printing dots per inch on a halftone film. A 
150lpi-screen ruling provides much better quality than 65lpi.

SEF A printer page orientation, where pages are delivered short end first.

Shadows The darkest part of an image (original and reproduction) having 
densities near to maximum density. In the reproduction, shadows are 
printed with dot areas between 80% and 100% See also Highlights 
and Midtones.

Shingling A procedure that moves the image area of a page toward the direction 
specified, usually towards the binding, in order to compensate for 
creep.

Signature Sheet of printed pages which when folded becomes part of the 
publication.

Solid The point in the picture printed with a dot area of 100%. See also 
Highlights, Midtones and Shadows.

Spectrophotometer Spectrophotometer (X-Rite DTP41), which is a 24 band color 
measurement instrument that reports densitometric, colorimetric 
and spectral data.

Spot color An additional separation (fifth, or more) that is used with special inks 
to achieve difficult color combinations, such as gold, or chocolate 
brown. Spot color is sometimes used by graphic artists to define 
special corporate colors, for example, for company logos. On the 
Spire CXP Color Server, spot colors are tanslated into CMYK values 
using a dictionary, that can be edited to adjust CMYK values.

Step and repeat The procedure of copying the same image by stepping it in position 
both horizontally and vertically according to a predetermined layout.

Stochastic screening A method of creating frequency-modulated halftones that depends 
on the number of laser dots in a given area rather than the size of the 
laser dots in a given area. The dots are randomly placed and very 
small. Areas with a higher dot percent have more spots exposed in 
that area and those with a low dot percent have fewer spots. Stochastic 
screening is used to eliminate moiré and improve picture detail and 
sharpness in high-end color printing.
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Subtractive color model A color process in which the red, green and blue components of the 
original subject are reproduced as three super-imposed images in the 
complementary (subtractive) colors of cyan, magenta and yellow 
respectively. See also CMYK, Process colors, Additive color model.

Three quartertone Tone area of an image influencing the shadow detail and with density 
values between the Midtone and the Dark Point. Typically printed 
with a dot area near 75%.

Tone compression The reduction of the density range of an original to the density range 
achievable in the reproduction.

Tone reproduction curve A graph showing the density of each point of the original and its 
corresponding density on the reproduction.

Trapping Creating and overlap (spread) or an underlap (choke) between colors 
that adjoin each other to hide misregistration during printing. 
Trapping is sometimes referred to as spreads and chokes, or fatties 
and skinnies.

UCR Abbreviation of Undercolor Removal. This is a method for reducing 
the CMY content in neutral gray shadow areas of a reproduction and 
replacing them with black. As a result, the reproduction appears 
normal but less process color inks are used. See also GCR.

Unsaturated color A color whose highest value is less than approximately 80%. In an 
unsaturated, dirty color, the difference in the values of the wanted 
colors and the unwanted color is relatively low. 

For example, when the color is red, 30% cyan, 80% magenta, 70% 
yellow is more unsaturated than 0% cyan, 90% magenta, 80% yellow.

Variable Information (VI) Variable information (VI) jobs are jobs in which the printed materials 
are individualized for specific recipients or purposes. These materials 
can include bills, targeted advertising and direct mailings.

Vector drawing The geometric system used to define lines and curves in many 
computer graphics most often used for line drawings.

Vignette See Degradé.

Virtual Printer For Macintosh and PC networks, the Spire CXP Color Server 
provides three default network printers, known as virtual printers. 
Virtual printers contain preset workflows that are automatically 
applied to all print jobs processed with that virtual printer. 
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White point The whitest neutral area of an original or reproduction that contains 
detail and is reproduced with the smallest printable dot (typically 3% 
to 5%).
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A
Aborted status,  43
Absolute colorimetric,  249
Accounting Log

exporting,  99
printing,  101
report,  96
setup,  164

Accounting Viewer
setting,  97
viewing log,  97

Adding
crop marks,  197
fold marks,  197
new virtual printer,  81

Admin Page,  203
Administration Items,  140
Alert Messages,  163
Alerts window,  169
AppleTalk Setup,  147
Archiving jobs,  46
Automatic job deletion

scanned jobs,  167
stored jobs,  169

B
Back Cover,  204
Basic configuration,  3
Basic configuration workflows,  12
Basic workflows,  59
Black overprint,  183
Book-finishing technique,  192
Booklets tab,  65
Brightness,  133,  190

slider,  136,  190
Bypass held jobs,  161

C
Calibration,  108

creating a table,  116
frequency,  115
full calibration,  116
guidelines,  113
quick calibration,  116

select table,  189
when to calibrate,  108
window,  122
wizard,  117
X-Rite DTP34 QuickCal 

densitometer,  113
Calibration Device,  155
Client workstations

Macintosh,  89
Windows,  86

CMYK
editing values,  128
workflow,  185

Collation,  177
Color

adjustments,  189
formats,  184
tools,  125

Color mode,  185
Color Server (basic), turning off,  12
Color Server (basic), turning on,  12
Color Server (Control Station and 

Pro), turning on,  28
Color settings,  161
Color Space Array (CSA),  185
Color Space Array. See CSA (Color 

Space Array)
Colorimetric

Absolute,  249
Relative,  257

Completed status,  43
Configuration

Backup,  152
report,  96
Restore,  153
view,  165

Consumables tab,  56
Contrast,  136,  190

center,  137
slider,  136

Control Station configuration,  3
Crop marks,  197
CSA (Color Space Array),  251
CT,  7
CT (Continuous Tone),  128,  188
Cut & Stack,  192

D
Date changing,  142
Default Archive Path

setting,  158
Default Gradation Table,  131
Default Paper Size

setting,  158
Deleting

pages from a job,  69
spot colors,  130
virtual printers,  84

Delivery,  177
Densitometer. See X-Rite DTP34 

QuickCal densitometer
Destination ICC profile

importing,  127
Device Link,  186

managing profiles,  125
Disk configuration,  213
Disk threshold,  151
Disk Usage tab,  53
Disk wipe,  150
Domain changing,  142
Downloads,  25
Duplex

head to head,  177
head to toe,  177

E
Editing

CMYK values,  128
pantone colors,  128
separations,  133
virtual printers,  83

Emulate
RGB elements,  187

EPS,  7
Exceptions

deleting exceptions,  207
managing exceptions,  206
managing inserts,  207
tab,  206

Exporting
accounting log,  99

Index
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F
Face down,  177
Face up,  177
Failed status,  43
File formats,  7
Filtering

messages,  173
Finisher,  205
Finisher tab,  55
First Time Software Setup & 

Configuration
Configuration Wizard

Test Print,  246
Fit to paper,  178
Fold marks,  197
Font Report,  106
Front Cover,  204
Frozen job,  33,  169,  180

G
Gallop,  179
GAP (Graphic art port),  7
GCR (Gray Component 

Replacement),  189
General Defaults,  158
Gradation,  189

brightness,  136
contrast,  136
dialog box,  131
graph,  133
list,  190
organizing tables,  137
separations,  133
tool,  131

H
Hardware components,  7
Held Jobs Policy,  161
Held status,  43
Help

online help,  53
Help menu,  53

I
ICC profiles,  125

deleting,  128

importing,  125
Image Position,  178
Image quality (Media Type),  180
Image quality (Print Quality),  182
Image Scale,  178
Importing

destination ICC profiles,  127
files,  60
jobs,  60
source ICC profiles,  125
user-defined imposition 

templates,  194
Imposed sheets,  67

view,  67
Imposition

method,  191
settings,  67
tab,  191

Imposition templates
deleting,  196
renaming,  195
user-defined,  194

Ink saving,  189
Inserts,  206
Internet Explorer,  24
IPX printing,  144

J
JDF Outputs,  166
Job

abort running,  39
accounting,  97
archiving,  46
batching,  37,  160
deleting,  42
deleting a frozen,  169
deleting pages,  69
duplicating,  45
editing parameters,  41
flow,  201
frozen,  33
history,  171
key components,  103
merging jobs,  69
move to storage,  40
moving pages,  68
Preview & Editor,  63
reprinting,  62

retrieving,  47
running job,  34
submitting,  45
ticket report,  101
waiting job,  34

Job Parameters window,  51
Color tab,  183
Exceptions tab,  206
Finishing tab,  203
Imposition tab,  191
Paper Stock tab,  179
Print Quality tab,  181
Print Settings tab,  176
Services tab,  198

L
Landscape,  177
Language,  156
Lead,  178
LEF (Long Edge Feed),  179
Localization,  156
LW (Line Work),  7,  128,  188

M
Mac OS X

copying PPD file,  89
setting network printer,  90

Macintosh,  8
printing from,  91

Media Type,  180
Menu bar,  30
Merging jobs,  69
Message Viewer,  171
Message Viewer Log

setup,  164
Messages,  163

system disks threshold,  170
Moving

pages within a job,  68
waiting jobs to storage,  40

N
Navigation buttons,  63
Network printer

setting for Mac OS X,  90
Network Setup,  144
Network tab,  54
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Number of copies,  176

O
Online help,  53
Orientation,  193
Override PPD parameters,  83

P
Page exceptions

Exceptions tab,  206
inserts,  206

Pantone colors,  128
Paper

tint,  187
Paper Size,  179
Paper Stock tab,  55,  179
Paper type,  180
Passwords,  149
PC,  8
PDF,  7
PDF optimization,  202
PDL files,  9
Perceptual (photographic),  256
Perfect bound,  192
Personal Print Markup Language 

(PPML),  7
Portrait jobs,  177
PowerPoint,  208
PPD file

copying for Mac OS X,  89
setting job parameters,  176,  208

PPML. See Personal Print Markup 
Language (PPML)

Preferences,  140
Preflight Report,  103
Pre-RIP Preview,  157
Preview

buttons,  64,  135
job,  64

Print grays using only black toner,  185
Print Method,  177
Print Order,  177
Print Quality tab,  181
Print Queue,  33

status indicators,  35
Print Queue Manager,  160
Print range,  177
Print Settings tab,  176

Printer Driver,  87
Printer icon,  32
Printer Monitor,  54
Printer’s Default,  88,  208
Printing

accounting log,  101
book-style hard copies,  177
jobs,  60

Printing Modes,  159
Process Queue,  33

status indicators,  35
ProcessPrint,  9,  81
ProcessStore,  9,  81
Product overview,  5
Professional configuration,  3
Professional Upgrade Kit,  3
Profile Manager,  125
PS overprint,  183
PS Preview,  157

Q
QuarkXPress,  129
Queues

changing order,  38
managing,  33
resuming,  39
suspending,  38
window,  33

QuickCal densitometer. See X-Rite 
DTP34 QuickCal densitometer

R
Rear,  178
Relative colorimetric,  257
Remote Access,  168
Remote Desktop Application,  16
Remote scan application,  73
Remote Tools Setup,  148
Rendering intent,  257

absolute colorimetric,  249
for CMYK,  186
perceptual (photographic),  256
relative colorimetric,  257
saturated (presentation),  258

Reordering columns,  173
Reports,  96

Accounting,  96,  97
Configuration,  96

Font List,  96
Job Ticket,  101
Preflight,  103
Printing from the printer-copier,  

96
Resource Center,  50

Fonts,  79
Imposition Templates,  194
Profile Manager,  125
Virtual Printers,  80

Restoring configuration,  153
Resume button,  38
Retrieving a job,  47
RGB Rendering intent,  185
RGB Workflow,  185
RIP,  5,  62
Rotate 180,  178
RTP,  5

editing RTP jobs,  68
jobs,  131

S
Saddle stitch,  192
Saturated (presentation),  258
Saturated color,  258
Scan,  167

managing scan boxes,  74
managing scanned images,  78
remote scan application,  73
scanning workflow,  77

Scanner Calibration,  109
Screening method,  188
Security,  149
SEF,  179
Separation,  133
Server icon,  32
Server Name,  141
Server Setup,  140
Settings

Administration,  140
Color,  161
Configuration Backup,  151
Date and Time,  142
General Defaults,  158
JDF Outputs,  166
Localization,  156
Messages,  163
Network Setup,  144



266 Spire CX250 Color Server User Guide

Preferences,  140
Pre-RIP Preview,  157
Print Queue Manager,  160
Remote Tools Setup,  148
Scan,  167
Security,  149
Server Name,  141
Server Setup,  140
System Disks,  151

Settings window,  49,  140
Signature colors,  249
Simplex,  177
Slip Sheet,  204
Software components,  7
Source ICC profiles

importing,  125
Spire Web Center,  148
Split to booklets,  202
SpoolStore,  9,  81,  201
Spot color

create new,  129
deleting,  130

Spot Color Editor,  128
Spot Colors Report,  105
Spot workflow,  187
Status

information,  36
of imported jobs,  61
panel,  30

Status indicators
Queues window,  35

Step & Repeat,  192
Storage Management,  168
Storage tab,  25
Storage window,  9,  40,  42

status indicators,  43
Submitting

an RTP job,  62
jobs,  45

Suspend button,  38
System Disks,  151
System partition

backup and restore,  214

T
TCP/IP Setup,  145
Test Page,  158
Text/Line quality,  181

Thumbnails,  31
tab,  66

Time changing,  142
Toolbar,  30
Trapping,  182
Trim size,  193
Turning off the Spire color server,  58
Turning on the Spire color server,  28

U
UNIX,  8
User Passwords,  149
User-defined imposition templates

deleting,  196
importing,  194
renaming,  195

Using overprint information,  183
Utilities folder,  25

V
Variable data Intelligent Postscript 

Printware (VIPP),  7
Variable Print Specification (VPS),  7
VI Job Preview,  157
View Configuration,  165
View menu,  32
Viewing

the imposed job,  67
VIPP. See  Variable data Intelligent 

Postscript Printware (VIPP)
Virtual printer,  80

adding,  81
deleting,  84
editing,  83
ProcessPrint,  81
ProcessStore,  81
SpoolStore,  81

Virtual Printers tab,  54
VPS. See Variable Print Specification 

(VPS)

W
Web Center

about,  93
connecting from a client,  24
Downloads,  25
Web Viewer,  24

Web Connect Setup,  148
Web connections

enabling,  148
Web Viewer,  24,  148

Alerts tab,  25
API,  25
Printer tab,  25
Queues tab,  25
Storage tab,  25

Windows
copying the PPD file,  87
printing from,  88
working from client workstations,  

86
Windows XP

defining a printer,  87
defining a printer using the add 

printer wizard,  13
Workflow,  8

importing and printing from the 
client,  86

Workgroup
changing,  142

Workspace,  30
customizing,  31

X
X-Rite DTP34 QuickCal densitometer

calibrating,  113,  115
configuring,  114
connecting,  114
full calibration,  116
quick calibration,  116
tutorial,  117
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